Wi-Fi or Wired Networking........................................................................................................................ 36
Network Security Recommendations ............................................................................................................. 36
Wi-Fi Infrastructure Mode Setup.................................................................................................................. 37
  Selecting Wireless Network Settings from the Control Panel .............................................................. 37
Wi-Fi Direct Mode Setup ............................................................................................................................ 40
  Enabling Wi-Fi Direct Mode .................................................................................................................. 40
Wi-Fi Protected Setup (WPS) .................................................................................................................... 43
  Using WPS to Connect to a Network .................................................................................................... 43
Printing a Network Status Sheet .............................................................................................................. 45
Printing a Network Connection Report ................................................................................................... 45
  Network Connection Report Codes and Messages ............................................................................. 46
Changing or Updating Network Connections ........................................................................................... 52
  Accessing the Web Config Utility ....................................................................................................... 53
  Changing a USB Connection to a Wi-Fi Connection ....................................................................... 53
  Changing a Wi-Fi Connection to a Wired Network Connection ....................................................... 53
  Connecting to a New Wi-Fi Router ..................................................................................................... 54
  Disabling Wi-Fi Features ...................................................................................................................... 54
Loading Paper ........................................................................................................................................... 56
  Loading Paper in the Sheet Feeder ...................................................................................................... 56
  Paper Loading Capacity ...................................................................................................................... 60
  Compatible Epson Papers ..................................................................................................................... 61
  Borderless Paper Type Compatibility ................................................................................................. 63
  Paper or Media Type Settings - Printing Software ........................................................................... 63
  Selecting the Paper Settings - Control Panel .................................................................................... 64
    Paper or Media Type Settings - Control Panel .............................................................................. 65
  Selecting the Default Paper Source Settings ..................................................................................... 66
    Paper Source Settings Options ....................................................................................................... 67
Placing Originals on the Product .............................................................................................................. 68
  Placing Originals on the Scanner Glass ............................................................................................ 68
  Placing Originals in the Automatic Document Feeder ...................................................................... 69
  ADF Original Document Specifications ............................................................................................... 71
Copying ...................................................................................................................................................... 73
  Copying Documents or Photos ........................................................................................................... 73
## Scanning

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting a Scan</td>
<td>116</td>
</tr>
<tr>
<td>Starting a Scan Using the Product Control Panel</td>
<td>116</td>
</tr>
<tr>
<td>Changing Default Scan Job Settings</td>
<td>118</td>
</tr>
<tr>
<td>Setting Up a WSD Port (Windows 7/Windows Vista)</td>
<td>118</td>
</tr>
<tr>
<td>Starting a Scan Using the Epson Scan 2 Icon</td>
<td>119</td>
</tr>
<tr>
<td>Starting a Scan from a Scanning Program</td>
<td>122</td>
</tr>
<tr>
<td>Starting a Scan from a Smart Device</td>
<td>124</td>
</tr>
<tr>
<td>Scanning in Epson Scan 2</td>
<td>124</td>
</tr>
<tr>
<td>Additional Scanning Settings - Main Settings Tab</td>
<td>127</td>
</tr>
<tr>
<td>Additional Scanning Settings - Advanced Settings Tab</td>
<td>127</td>
</tr>
<tr>
<td>Saving Scanned Documents as a Searchable PDF Using Epson Scan 2</td>
<td>128</td>
</tr>
<tr>
<td>Image Format Options</td>
<td>130</td>
</tr>
<tr>
<td>Scan Resolution Guidelines</td>
<td>131</td>
</tr>
</tbody>
</table>

## Faxing

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting a Telephone or Answering Machine</td>
<td>132</td>
</tr>
<tr>
<td>Setting Up Fax Features</td>
<td>135</td>
</tr>
<tr>
<td>Setting Up Basic Fax Features</td>
<td>135</td>
</tr>
<tr>
<td>Using the Fax Setting Wizard</td>
<td>136</td>
</tr>
<tr>
<td>Selecting the Line Type</td>
<td>139</td>
</tr>
<tr>
<td>Setting the Number of Rings to Answer</td>
<td>139</td>
</tr>
<tr>
<td>Selecting Advanced Fax Settings</td>
<td>140</td>
</tr>
<tr>
<td>Receive Settings - Fax</td>
<td>141</td>
</tr>
<tr>
<td>Basic Settings - Fax</td>
<td>142</td>
</tr>
<tr>
<td>Report Settings - Fax</td>
<td>144</td>
</tr>
<tr>
<td>Security Settings - Fax</td>
<td>145</td>
</tr>
<tr>
<td>Setting Up the Fax Utility - Windows</td>
<td>145</td>
</tr>
<tr>
<td>Setting Up Fax Features Using the Fax Utility - Mac</td>
<td>147</td>
</tr>
<tr>
<td>Setting Up Contacts and Contact Groups</td>
<td>148</td>
</tr>
</tbody>
</table>
Network Software Cannot Find Product on a Network ................................................................. 223
Product Does Not Appear in Mac Printer Window ....................................................................... 224
Wireless Network Connection is Unstable on a Mac ................................................................... 224
Wired Network Connection Becomes Unstable ............................................................................. 224
Cannot Print Over a Network ....................................................................................................... 225
Cannot Scan Over a Network ....................................................................................................... 226

Solving Copying Problems ............................................................................................................... 227
Product Makes Noise, But Nothing Copies .................................................................................. 227
Product Makes Noise When It Sits for a While ............................................................................. 228

Solving Paper Problems ................................................................................................................... 228
Paper Feeding Problems ............................................................................................................. 228
Paper Jams Inside the Product .................................................................................................... 229
Paper Ejection Problems ............................................................................................................. 229

Solving Problems Printing from a Computer ..................................................................................... 230
Nothing Prints .............................................................................................................................. 230
Product Icon Does Not Appear in Windows Taskbar ................................................................... 231
Printing is Slow ............................................................................................................................ 232

Solving Page Layout and Content Problems ..................................................................................... 233
Inverted Image ............................................................................................................................. 234
Too Many Copies Print ................................................................................................................ 234
Blank Pages Print ........................................................................................................................ 234
Incorrect Margins on Printout ...................................................................................................... 235
Border Appears on Borderless Prints .......................................................................................... 235
Incorrect Characters Print ............................................................................................................ 236
Incorrect Image Size or Position .................................................................................................. 237
Slanted Printout ........................................................................................................................... 238

Solving Print Quality Problems ......................................................................................................... 238
White or Dark Lines in Printout .................................................................................................... 239
Blurry or Smeared Printout .......................................................................................................... 240
Faint Printout or Printout Has Gaps ............................................................................................. 242
Grainy Printout ............................................................................................................................. 243
Incorrect Colors ........................................................................................................................... 244

Solving Scanning Problems ............................................................................................................. 245
L5190 User's Guide

Welcome to the L5190 User's Guide.
For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

Using the Control Panel
Product Parts Locations
Using Power Saving Settings
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Using Google Cloud Print
Using the Mopria Print Service
Android Printing Using the Epson Print Enabler
Using Fire OS Printing
Using Windows 10 Mobile Printing

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights
Entering Characters on the LCD Screen
Changing LCD Screen Language
Selecting the Date and Time
Adjusting Control Panel Sounds
Preventing PC Connection via USB

Parent topic: Product Basics

Control Panel Buttons and Lights

![Diagram of control panel buttons and lights]
1  power button and light
2  LCD screen
3  help button
4  Arrow buttons and OK button
5  stop button
6  Numeric keypad
7  clear button
8  start button
9  reset button
10  back button
11  received fax light
12  home button

Status Icon Information

Parent topic: Using the Control Panel

Status Icon Information

Your product displays status icons on the LCD screen for certain product status conditions.

<table>
<thead>
<tr>
<th>Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="wifi" /></td>
<td>No Wi-Fi connection.</td>
</tr>
<tr>
<td><img src="image2" alt="wifi_error" /></td>
<td>A Wi-Fi network error has occurred or the product is searching for a connection.</td>
</tr>
<tr>
<td><img src="image3" alt="wifi_strength" /></td>
<td>A Wi-Fi connection is established. The number of bars indicates the connection’s signal strength.</td>
</tr>
<tr>
<td><img src="image4" alt="no_wifi" /></td>
<td>No Wi-Fi Direct connection.</td>
</tr>
<tr>
<td><img src="image5" alt="direct_wifi" /></td>
<td>A Wi-Fi Direct connection is established.</td>
</tr>
<tr>
<td><img src="image6" alt="ethernet" /></td>
<td>An Ethernet connection is established.</td>
</tr>
<tr>
<td>Icons</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>🕵️‍♀️</td>
<td>No Ethernet connection.</td>
</tr>
</tbody>
</table>

Parent topic: Control Panel Buttons and Lights

**Entering Characters on the LCD Screen**

Follow these guidelines to enter characters for passwords and other settings.

- To enter characters, press the buttons on the numeric keypad.
- To change the character case or type, press the reset button.
- To move the cursor to the right or to add a space, press the right arrow button.
- To move the cursor to the left, press the left arrow button.
- To enter symbols, press 1 on the numeric keypad.
- To delete the previous character, press the stop button.
- To delete all the characters, press the clear button.

**Changing LCD Screen Language**

You can change the language used on the LCD screen.
1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.

3. Select Printer Setup and press the OK button.

4. Select Language and press the OK button.
5. Select a language and press the OK button.
6. Press the home button to exit.

Parent topic: Using the Control Panel
Selecting the Date and Time

Select the current date, time, and daylight saving phase in your area, and choose your preferred date and time format.

1. Press the home button, if necessary.
2. Select Settings and press the OK button.
3. Select Printer Setup and press the OK button.
4. Select Date/Time Settings and press the OK button.
   You see a screen like this:

   ![Printer Setup]

5. Select Daylight Saving Time and press the OK button.
6. Select the setting that applies to your area and press the OK button:
   - Winter: it is winter or your region does not use Daylight Saving Time (DST)
   - Summer: it is spring or summer and your region uses Daylight Saving Time (DST)

   **Note:** If your region uses Daylight Saving Time (DST), you must change this setting to match the season. When you change from Winter to Summer, your product automatically sets its clock ahead one hour. When you change from Summer to Winter, it sets its clock back one hour.

7. Select Date/Time and press the OK button.
8. Select the date format you want to use and press the OK button.
9. Use the arrow buttons and the numeric keypad to enter the current date, then press the OK button.
10. Select the time format you want to use and press the OK button.
11. Use the numeric keypad, arrow buttons and the reset button to enter the current time, then press the OK button.
12. Select Time Difference and press the OK button.
13. Use the arrow buttons to enter the time difference between your time zone and UTC (Coordinated Universal Time) and press the OK button.

Parent topic: Using the Control Panel

Adjusting Control Panel Sounds
You can adjust the sound level heard when you perform certain control panel operations, such as pressing buttons on the control panel.

1. Press the home button, if necessary.
2. Select Settings and press the OK button.
3. Select Printer Setup and press the OK button.
   You see a screen like this:

   ![Printer Setup screen]

4. Select Sound and press the OK button.
5. Do one of the following:
   - To mute all the control panel sounds, select Mute and press the OK button.
• To use normal control panel sound levels, select **Normal Mode** and press the **OK** button.
• To reduce noise during printing, select **Quiet Mode** and press the **OK** button.

**Note:** Using **Quiet Mode** may reduce the print speed, and may not reduce printing noise when using certain paper types or print quality settings.

6. Select the control panel operation for which you want to adjust the sound level, such as **Button Press**, and press the **OK** button.

You see a screen like this:

![Button Press screen](image)

7. Press the left or right arrow button to adjust the volume.
8. Press the **OK** button to exit.

**Parent topic:** Using the Control Panel

### Preventing PC Connection via USB

You can disable access to your product from a USB-connected computer. This restricts non-network access to the product.

1. Press the **home** button, if necessary.
2. Select **Settings** and press the **OK** button.
3. Select **Printer Setup** and press the **OK** button.
4. Select **PC Connection via USB** and press the **OK** button.
You see a screen like this:

![Screen with options](image)

5. Select **Disable** and press the **OK** button.
6. Do one of the following:
   - Press the **OK** button to restart the product.
   - Press the stop button to return to the Printer Setup screen without restarting the product.

   **Note:** The change will not take effect until the product is restarted.

**Parent topic:** Using the Control Panel

**Product Parts Locations**

See these sections to identify the parts on your product.

- Product Parts - Front
- Product Parts - Inside
- Product Parts - Back

**Parent topic:** Product Basics
Product Parts - Front

1 Automatic Document Feeder (ADF) cover
2 ADF input tray
3 ADF edge guide
4 ADF output tray

1 Rear paper feed
2 Paper support
3 Edge guides
4 Output tray

Parent topic: Product Parts Locations
Product Parts - Inside

1. Document cover
2. Scanner glass
3. Control panel

1. Inner cover
2. Ink tank unit
3. Ink tanks
4. Ink tank cover
Using Power Saving Settings

Your product enters sleep mode automatically and turns off the LCD screen if it is not used for a period of time. You can make the time period shorter and select other options to save energy and resources.

Changing the Sleep Timer Setting from the Control Panel
Changing the Power Off Timer Setting from the Control Panel

Changing the Sleep Timer Setting from the Control Panel

You can use the product's control panel to change the time period before the product enters sleep mode.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.
3. Select **Printer Setup** and press the **OK** button. You see this screen:

![Printer Setup screen](image)

4. Select **Sleep Timer** and press the **OK** button. You see this screen:

![Sleep Timer screen](image)

5. Use the numeric keypad to adjust the number of minutes of inactivity before the product enters sleep mode. Then press the **OK** button.

6. Press the home button to exit.

**Parent topic:** [Using Power Saving Settings](#)
Changing the Power Off Timer Setting from the Control Panel

You can use the product's control panel to change the time period before the printer turns off automatically.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Settings and press the OK button.
3. Select Printer Setup and press the OK button.

You see this screen:

4. Select Power Off Timer and press the OK button.
You see this screen:

![Power Off Timer]

5. Select the length of time after which you want the product to automatically turn off when it is not in use. Then press the OK button.
6. Press the home button to exit.

Parent topic: Using Power Saving Settings

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print and scan documents, photos, emails, and web pages from your home, office, or even across the globe.

**Note**: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Print from anywhere with these Epson Connect solutions:

- Epson Email Print
- Epson iPrint Mobile App
- Epson Remote Print

Scan and send a file as an email or upload it to an online service directly from your Epson product with the Epson iPrint Mobile App.
Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your product, you can activate it using the product control panel.

1. Press the home button, if necessary.
2. Press the left or right arrow button to select Settings and press the OK button.
3. Press the arrow buttons to select Epson Connect Services and press the OK button.
   You see this screen:

   ![Epson Connect Screen]

4. Press the OK button to select Register/Delete.
5. Press the **OK** button to select **Yes**.
6. Follow the instructions on your screen to activate your product's email address.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

---

**Using Epson Email Print**

With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the attachments will print automatically.

1. Connect your product to your network. See the link below.
2. If you did not already set up Email Print when you installed your product software, see the link below to use your product control panel to activate your unique email address. Or visit epsonconnect.com to learn more about Email Print, create your Epson Connect account, and register your product to the Epson Connect service.
3. Now you are ready to send and print emails to your product's Email Print address.

**Note:** Go to epsonconnect.com and log into your Epson Connect account to personalize your product's email, adjust print settings, and set up other Epson Connect services.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related tasks**

Setting Up Epson Connect Services

**Related topics**

Wi-Fi or Wired Networking

---

**Using the Epson iPrint Mobile App**

Use this free Apple and Android app to print and scan with networked Epson products. Epson iPrint lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can scan and save a file on your device, send it as an email, or upload it to an online service such as Box, Dropbox, Evernote, or Google Drive.

1. Connect your product to your wireless network. See the link below.
2. Visit epson.com.jm/connect to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print or scan with your mobile device and your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking

---

**Using Epson Remote Print**

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.
2. If you did not already set up an Epson Connect account when you installed your product software, visit epsonconnect.com to create your account and register your product to the Epson Connect service.

   **Note:** Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print Driver software.
4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.
6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer application and choose the Remote Print option for your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

**Related topics**

Wi-Fi or Wired Networking
Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, iPod touch, and Mac without the need to install drivers or download software.

Note: If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to enable the messages, if necessary.

1. Load paper in your product.
2. Set up your product for wireless printing. See the link below.
3. Connect your Apple device to the same wireless network that your product is using.
4. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics
Related references
Paper Source Settings Options
Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can also print from Chromebooks and the Google Chrome browser without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Note your product's IP address by checking your network status. See the link below.
3. Connect your computer or your Apple or Android device to the same wireless network as your Epson product.
4. Enter your product's IP address into the address bar of a web browser.
5. Select the **Google Cloud Print Services** option.

   **Note:** If you don’t see the **Google Cloud Print Services** option, turn your product off and back on. If the option still doesn't appear, select the **Firmware Update** option and follow the on-screen instructions to update your product.

6. Click **Register**.
7. Select the checkbox to agree to the Usage Advisory and click **Next**.
8. Click **OK** to launch the sign-in page.
   A separate browser window opens.
9. Enter your Google Account username and password and click **Sign in**, or, if you don't have an account, click **Sign up for a new Google Account** and follow the on-screen instructions.
10. Click **Finish printer registration** to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, computer, Apple or Android device with Internet access. For more information on using Google Cloud Print and for a list of supported apps, visit the Google Cloud Print site.

**Setting Up Google Cloud Print on a Chromebook**

**Parent topic:** Product Basics

**Related tasks**

- Printing a Network Status Sheet

**Related topics**

- Wi-Fi or Wired Networking

---

**Setting Up Google Cloud Print on a Chromebook**

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

   **Note:** See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:
   - Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.
Note: If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click Add to Cloud Print.

- Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
- If you see a registration confirmation screen instead, click Register.

4. Click Add Device.
5. Click the Register button that appears next to your product.
6. Click Register on the confirmation screen. Your product’s LCD screen displays a confirmation message.
7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone, or Android phone with Internet access. For more information on using Google Cloud Print and for a list of supported apps, visit the Google Cloud Print site.

Parent topic: Using Google Cloud Print
Related topics
Wi-Fi or Wired Networking

Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to your Epson product or any Mopria-certified product from other manufacturers. You can download the Mopria Print Service from Google Play.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Mopria Print Service app from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

3. Go to Settings on your Android device, select Printing, and enable the Mopria Print Service.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and select Print. Then select All printers, select your Epson product, adjust your print settings, and print.
You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson product and print.

1. Connect your Epson product to your wireless network. See the link below.
2. On your Android device, download the Epson Print Enabler plug-in from Google Play.
3. Go to Settings on your Android device, select Printing, and enable the Epson plug-in.
4. Connect your Android device to the same wireless network as your product.
5. Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu icon and print whatever is on the screen.

**Note:** If you do not see your product, tap All Printers and select your product.

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. With just a few taps in Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.
3. Now you are ready to print. From your Amazon application, tap the print option and select your product to print whatever is on the screen.

**Note:** If you see a message telling you that a plug-in is required, tap OK and tap Download. If your Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria Print Service app to print.
Visit epson.com.jm/connect to learn more about Fire OS Printing (one of many Epson Connect Partner Solutions) and check the compatibility of your mobile device.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson product. There is no software to download, no drivers to install, and no cables to connect. Look for the print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.
3. Now you are ready to print. From your Windows 10 application, tap the print option and select your product to print whatever is on the screen.

Visit epson.com.jm/connect to learn more about Windows 10 Mobile Printing (one of many Epson Connect Partner Solutions) and check the compatibility of your mobile device.

Parent topic: Product Basics
Related topics
Wi-Fi or Wired Networking
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Network Security Recommendations

Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Printing a Network Connection Report
Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and fax lines, and other intrusions:

• **Enable security on your wireless LAN**
  Enable the appropriate security on the wireless LAN you plan to use with your product. Network security such as a network password can deter interception of traffic over the wireless LAN. Your router may already have a default password enabled by your Internet service provider (ISP). See your ISP and router documentation for instructions on how to change the default password and better secure your network.

• **Connect your product only to a network protected by a firewall**
  Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead, connect it to a router or other network connection protected by a firewall. Your router may already have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best results, set up and use a private IP address for your network connection.

• **Change the default administrator password on your product**
  If your product has an option to set an administrator password, change the default administrator password to deter access by unauthorized users to personal data stored on your product, such as IDs, passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel

Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings from the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install the necessary software. The installer program guides you through network setup.
Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your network data and settings.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup and press the OK button.

You see this screen:

![Network screen](image)

3. Press the arrow buttons to select Wi-Fi (Recommended) and press the OK button twice.
4. Press the arrow buttons to select Wi-Fi Setup Wizard and press the OK button.
5. Press the arrow buttons to select the name of your wireless network and press the OK button. If you do not see your wireless network’s name, you can enter it manually.

Note: To enter the wireless network name manually, select Other SSIDs and press the OK button. Enter your network name as described in the next step.
6. Enter your wireless password (or network name and then password).

7. If you want to print a network setup report, press the start button. (Otherwise, press the stop button.)

Your product should now display a blue Wi-Fi symbol on the LCD screen.

Note: If the Wi-Fi symbol is not displayed on the LCD screen as shown above, you may have selected the wrong network name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup
Related tasks
Printing a Network Status Sheet
Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network access point for up to 8 devices.

1. Epson product
2. Computer with a wireless interface
3. Other wireless device

Enabling Wi-Fi Direct Mode

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

Note: If you are printing from a computer, make sure you installed the network software as described on the Start Here sheet.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
3. Press the right arrow button to select **Wi-Fi Direct** and press the **OK** button.
4. Press the **OK** button twice.

You see this screen:

![Network Screen](image)

5. Press the down arrow button and then press the arrow buttons to select **Change Password**.
6. Press the **OK** button.
7. Press the **OK** button to change the Wi-Fi Direct password.

**Note:** If you have already connected devices or computers to your product via Wi-Fi Direct, they will be disconnected when you change the password.
8. Enter your Wi-Fi Direct password.

**Note:** Your password must be at least 8 and no more than 22 characters long.

- To enter characters, press the buttons on the numeric keypad.
- To change the character case or type, press the reset button.
- To move the cursor to the right or to add a space, press the right arrow button.
- To move the cursor to the left, press the left arrow button.
- To enter symbols, press 1 on the numeric keypad.
- To delete the previous character, press the stop button.
- To delete all the characters, press the clear button.
- When you finish entering characters, press the OK button.

9. Press the OK button.

**Note:** Make a note of the SSID and password that appear.

10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then press the OK button.

11. Use your computer or wireless device to enter the password displayed on the LCD screen.

12. Press the OK button twice to exit.
You see the icon on the LCD screen and should be able to connect to your product directly from your computer or device, and then print.

**Note:** If the icon is displayed on the LCD screen, Wi-Fi Direct mode is not enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

### Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled WPS on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

Using WPS to Connect to a Network

Parent topic: Wi-Fi or Wired Networking

#### Using WPS to Connect to a Network

If you have a WPS-enabled router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the WPS button on your router.
2. On the product, press the home button, if necessary.
3. Press the arrow buttons to select **Wi-Fi Setup** then press the OK button.
You see this screen:

4. Press the **OK** button twice.
   You see this screen:

   ![Network Screen](image)

   ![Connect via Wi-Fi Screen](image)

5. Press the arrow buttons to select **Push Button Setup (WPS)** and press the **OK** button.
6. Follow the instructions on the LCD screen to complete WPS setup.
   If the network connection is successful, the 📡 icon is displayed on the LCD screen.

   **Note:** If the 📡 icon is not displayed on the LCD screen, repeat these steps to try again.
Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet for detailed information about your product's network status.

1. Press the home button, if necessary.
2. Select Settings > Network Settings > Print Status Sheet.
   
   You see this screen:

   ![Print network status sheet?](image)

3. Press the start button to print the network status sheet.
   
   If you want to cancel the operation, press the stop button.

Examine the settings shown on the network status sheet to diagnose any problems you have.

Parent topic: Wi-Fi or Wired Networking

Related tasks
Accessing the Web Config Utility

Printing a Network Connection Report

You can print a network connection report to view solutions to any problems you may have using your product on a network.

1. Press the home button, if necessary.
2. Select Settings > Network Settings > Connection Check.
You see a screen like this:

![Screen showing network connection report]

3. Press the start button to print the network connection report.
   Examine any error codes and solutions shown on the network connection report.

Network Connection Report Codes and Messages

Parent topic: Wi-Fi or Wired Networking

Network Connection Report Codes and Messages

Check the error codes and messages on the network connection report to solve problems you may encounter with network connections. The tables here list solutions to problems based on the error codes and messages that may appear on the top of the report.

1. Error code
2. Message
**Note:** Error codes and messages listed here may not all apply to your product.

## Error Codes and Messages

<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1</td>
<td>Make sure your router, access point, and/or hub are turned on, and the network cable is securely connected to your device and to your product. If you are trying to set up Wi-Fi, remove the network cable and set up Wi-Fi again. Ethernet and Wi-Fi cannot be connected at the same time.</td>
</tr>
</tbody>
</table>

Confirm that the network cable is connected and network devices such as hub, router, or access point are turned on.
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
</table>
| E2, E3, or E7          | Check the following:  
  • Make sure your router or access point is turned on, and is correctly connected to your computer or network device.  
  • Turn off the router or access point, wait about 10 seconds, and turn it on again.  
  • Move your product closer to your router or access point, and remove any obstacles between them. Also move your product away from devices such as wireless phones or microwaves.  
  • Confirm that the SSID shown on the network connection report matches the label on your router or access point. Also make sure your SSID uses only ASCII characters and symbols, or your product cannot display the SSID correctly.  
  • If you are trying to connect using the WPS push button method, make sure your router or access point supports it.  
  • If you are using a network password, check the label on your router or access point to confirm that you are using the correct password, or check with your network administrator or router/access point documentation.  
  • If you are connecting to a smart device that generates an SSID, check the device documentation for the SSID and password you should use.  
  • If your wireless connection suddenly disconnects, and another smart device was added to the network using a WPS push button method or your network was set up using a non-WPS push button method, try downloading and installing your product software again. |
<p>| No wireless network names (SSID) found. Confirm that the router/access point is turned on and the wireless network (SSID) is set up correctly. Contact your network administrator for assistance. |  |
| No wireless network names (SSID) found. Confirm that the wireless network name (SSID) of the PC you wish to connect is set up correctly. Contact your network administrator for assistance. |  |
| Entered security key/password does not match the one set for your router/access point. Confirm security key/password. Contact your network administrator for assistance. |  |</p>
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
</table>
| E5                     | If the security on your router or access point is not one of the following types, change the type of security on your router or access point and reset your product's network settings.  
• WEP-64 bit (40 bit)  
• WEP-128 bit (104 bit)  
• WPA PSK (TKIP/AES); also known as WPA Personal  
• WPA2 PSK (TKIP/AES); also known as WPA2 Personal  
• WPA (TKIP/AES)  
• WPA2 (TKIP/AES)  
Also make sure you are connecting to the 2.4GHz band on your network and using the password for that band. |
| E6                     | If your router or access point has MAC address filtering enabled, register your product's MAC address so it is not filtered. Locate the MAC address on the network connection report and check your router or access point documentation for instructions.  
If your router or access point is using shared authentication with WEP security, confirm that you are using the correct authentication key and index.  
If your router or access point limits the number of connected devices, raise the connection limit. See your router or access point documentation for instructions. |
| E8                     | If your product's Obtain IP Address setting is set to Auto, enable DHCP on your router or access point. If it is set to Manual, the IP address may be out of range or on a different network segment; set a valid IP address using your product control panel or the Web Config utility.  
You can also try turning off your product and the router or access point, waiting about 10 seconds, and turning them on again. |
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>E9</td>
<td>Make sure your computer or network device are turned on. Also make sure that you can access the internet and other devices on the same network from the devices you are trying to connect to your product. If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. Download and install your product software again to reset your network settings.</td>
</tr>
</tbody>
</table>
| E10                    | Make sure other devices on the network are turned on and do the following:  
  - If your product's Obtain IP Address setting is set to Manual, check the IP address, subnet mask, and default gateway addresses on the network connection report to see if they are correct. If not, correct the settings.  
  - If DHCP is enabled, set your product's Obtain IP Address setting to Auto. If you want to use the DHCP-assigned address as a static address, set the Obtain IP Address setting to Manual, enter the product's IP address as listed on the network connection report, and set the subnet mask to 255.255.255.0.  
If you still cannot connect to your product, turn off your router or access point, wait about 10 seconds, and turn it on again. |
<p>| E11                    | If you set your product's TCP/IP Setup setting to Manual, check that the default gateway address listed on the network connection report is correct. Also turn on the device that is set as the default gateway. |</p>
<table>
<thead>
<tr>
<th>Error code and message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>E12</strong></td>
<td>Make sure other devices on the network are turned on and do the following:</td>
</tr>
<tr>
<td>Confirm the following</td>
<td>- Make sure the IP address, subnet mask, and default gateway addresses are correct, if you are entering them manually.</td>
</tr>
<tr>
<td>- Entered security key/password is correct</td>
<td>- Confirm that the subnet mask and default gateway addresses for other devices are the same.</td>
</tr>
<tr>
<td>- Index of the security key/password is set to the first number</td>
<td>- Make sure the IP address does not conflict with other devices.</td>
</tr>
<tr>
<td>- IP address, subnet mask, or default gateway setup is correct</td>
<td><strong>E13</strong> Confirm the following</td>
</tr>
<tr>
<td>Contact your network administrator for assistance.</td>
<td>Make sure your router, access point, and/or hub are turned on. Also make sure the TCP/IP setup on your router, access point, and/or hub is not set manually; this may cause your product's network settings to differ from the manually setup devices.</td>
</tr>
<tr>
<td></td>
<td>If you still cannot connect to your product, do the following:</td>
</tr>
<tr>
<td></td>
<td>- Turn off your router or access point, wait about 10 seconds, and turn it on again.</td>
</tr>
<tr>
<td></td>
<td>- Download and install your product software again to reset your network settings.</td>
</tr>
<tr>
<td></td>
<td>- If your router or access point uses WEP security with several registered passwords, make sure that the first registered password is set on your product.</td>
</tr>
</tbody>
</table>
Network Environment Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The same SSID may be set on several access points.</td>
<td>Check the settings on your router and other access points to make sure each one uses a different SSID.</td>
</tr>
<tr>
<td>The Wi-Fi environment needs to be improved. Turn the wireless router off and then turn it on. If the connection does not improve, see the documentation for the wireless router.</td>
<td>Move your product closer to your router or access point, and remove any obstacles between them. Then turn off your router or access point, wait about 10 seconds, and turn it back on again. If you still cannot connect to your product, check the documentation that came with your router or access point for solutions.</td>
</tr>
<tr>
<td>*No more devices can be connected. Disconnect one of the connected devices if you want to add another one.</td>
<td>You can connect up to 8 computers or other devices to your product using a Wi-Fi Direct (Simple AP) connection. If you want to add another device, disconnect an existing connected device first.</td>
</tr>
<tr>
<td>The same SSID as Wi-Fi Direct exists in the environment. Change the Wi-Fi Direct SSID if you cannot connect a smart device to the printer.</td>
<td>Change the Wi-Fi Direct SSID.</td>
</tr>
</tbody>
</table>

Parent topic: Printing a Network Connection Report

Related concepts

Wi-Fi Direct Mode Setup

Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

- Accessing the Web Config Utility
- Changing a USB Connection to a Wi-Fi Connection
- Changing a Wi-Fi Connection to a Wired Network Connection
- Connecting to a New Wi-Fi Router
- Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking
Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser. You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections
Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections
Related concepts
Uninstall Your Product Software

Changing a Wi-Fi Connection to a Wired Network Connection
If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product's LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Uninstall your product software.
5. Download and install your product software from the Epson website.
6. Follow the on-screen instructions to install the software.
7. When you see the Select Your Connection screen, select **Wired network connection**.
8. If you see a Select Setup Option screen, select **Set up printer for the first time**.
9. Continue following the rest of the on-screen instructions.

**Parent topic:** Changing or Updating Network Connections

**Related concepts**

- Uninstall Your Product Software

**Related tasks**

- Disabling Wi-Fi Features

### Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

1. Do one of the following:
   - **Windows:** Uninstall your product software.
   - **Mac:** Go to the next step.
2. Download and install your product software from the Epson website using the instructions on the *Start Here* sheet.

**Parent topic:** Changing or Updating Network Connections

**Related concepts**

- Uninstall Your Product Software

### Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.
Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. Press the home button, if necessary.
2. Press the arrow buttons to select Wi-Fi Setup and press the OK button.
3. Press the arrow buttons to select either Wi-Fi (Recommended) or Wi-Fi Direct and press the OK button.
4. Do one of the following:
   • If you selected Wi-Fi (Recommended), press the OK button, press the arrow buttons to select Others, and press the OK button again. Press the arrow buttons to select Disable Wi-Fi and press the OK button.
   • If you selected Wi-Fi Direct, press the OK button twice. Press the down arrow button, press the arrow buttons to select Disable Wi-Fi Direct, and press the OK button again.
5. Press the OK button to disable your product's Wi-Fi features.

Parent topic: Changing or Updating Network Connections
Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in the Sheet Feeder
Paper Loading Capacity
Compatible Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings - Printing Software
Selecting the Paper Settings - Control Panel
Selecting the Default Paper Source Settings

Loading Paper in the Sheet Feeder

You can print documents and photos on a variety of paper types and sizes.

1. Pull out the paper support.

2. Slide the edge guides out all the way.
3. If you are inserting a stack of paper, fan the sheets first and tap the stack on a flat surface to even the edges.

![Image of paper being fanned and tapped]

**Note:** Do not fan or curl photo paper.

4. Do one of the following:
   - Insert paper, glossy or printable side up and short edge first, in the center of the paper support.

![Image of paper being inserted]

   - Load up to 10 envelopes in the center of the paper support. Load them printable side up and flap edge left.

![Image of envelopes being loaded]
• Load a sheet of loose-leaf or other paper with holes facing as shown.

![Image showing correct and incorrect paper orientation]

• To load a sheet of paper longer than legal size, close the paper support, then load the leading edge of the paper as shown.

![Image of paper being loaded]

5. Slide the edge guide against the paper, but not too tightly.

![Image of edge guide being adjusted]
6. Pull out the output tray.

7. If prompted by the product's LCD screen, select the size and type of the paper you loaded and press the OK button.

Always follow these paper loading guidelines:

- Do not load more than the maximum number of sheets specified for the type of paper you are using.
- Do not load paper above the arrow mark inside the edge guides.
- Load paper short edge first.

**Note:** You can load paper long edge first only if you have selected the User-Defined paper size setting and set the width of the paper as the size of the long edge.

- Load letterhead or pre-printed paper top edge first.
- Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or curled, or paper that has stickers on it. Using these types of paper can cause paper jams and smears on the printout.
- Fan and align the edges of envelopes before loading them. When stacked envelopes are puffed up with air, flatten them before loading.
- Do not load envelopes that are curled, folded, or too thin, or that have plastic windows or adhesive surfaces.
- Check the paper package for any additional loading instructions.
- Return unused paper to its packaging to avoid curling or reduction in print quality.
• If you use paper with binder holes, load only one sheet at a time. Adjust the print position of your file to avoid printing over the holes.

Parent topic: Loading Paper

Related references
Paper Loading Capacity

Related tasks
Selecting the Default Paper Source Settings

Paper Loading Capacity

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
<th>Double-sided capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Available paper sizes*</td>
<td>30 sheets</td>
</tr>
<tr>
<td>Copy paper</td>
<td>Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches [210 x 297 mm]) or smaller: Up to the line indicated by the arrow mark</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Available paper sizes*</td>
<td>1 sheet</td>
</tr>
<tr>
<td></td>
<td>Oficio 9 (8.46 x 12.4 inches [215 x 315 mm]) or 8.5 x 13 inches [216 x 330 mm] or larger: 1 sheet</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>80 sheets</td>
<td>—</td>
</tr>
<tr>
<td>Epson High Quality Ink Jet Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>Loading capacity</td>
<td>Double-sided capacity</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>20 sheets If paper feeds incorrectly, or printing is uneven or smeared, load 1 sheet at a time.</td>
<td>—</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>1 sheet</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Envelopes</td>
<td>10 envelopes</td>
<td>—</td>
</tr>
</tbody>
</table>

* Select the paper specification link below to view the list of available paper sizes.

**Parent topic:** Loading Paper  
**Related references**  
Paper Specifications

### Compatible Epson Papers

You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit epson.com.jm or call your nearest Epson sales office.

**Note:** Paper/media availability varies by country.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257-ML</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Epson High Quality Ink Jet Paper</td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>S041117</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041111</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>S041140</td>
<td>20</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>16:9 wide (4 × 7.1 inches [102 × 181 mm])</td>
<td>S042109</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041286-ML</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331-ML</td>
<td>20</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

**Borderless Paper Types**
- Epson Photo Paper Glossy
- Epson Premium Photo Paper Glossy
- Epson Ultra Premium Photo Paper Glossy
- Epson Premium Photo Paper Semi-gloss

**Borderless Paper Sizes**
- 4 × 6 inches (102 × 152 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper / Bright White Paper</td>
</tr>
</tbody>
</table>

63
For this paper | Select this paper Type or Media Type setting
---|---
Envelopes | Envelope
Epson Ultra Premium Photo Paper Glossy | Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy | Premium Photo Paper Glossy
Epson Photo Paper Glossy | Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss | Premium Photo Paper Semi-Gloss
Epson Presentation Paper Matte | Presentation Paper Matte
Epson Premium Presentation Paper Matte | Premium Presentation Paper Matte
Epson Ultra Premium Presentation Paper Matte | Premium Presentation Paper Matte
Epson High Quality Ink Jet Paper | Premium Presentation Paper Matte

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product's control panel settings.

**Parent topic:** Loading Paper

### Selecting the Paper Settings - Control Panel

You can change the default paper size and paper type using the control panel on the product.

**Note:** These settings appear automatically when paper is inserted when you have set the Paper Setup Auto Display setting to On.

1. Press the home button, if necessary.
2. Use the arrow and OK buttons to select Settings > Printer Setup > Paper Source Settings > Paper Setting.
You see a screen like this:

3. Select **Paper Size**.
4. Select the paper size you loaded.
5. Select **Paper Type**.
6. Select the paper type you loaded.
7. Press the home button to exit.

**Paper or Media Type Settings - Control Panel**

**Parent topic:** Loading Paper

### Paper or Media Type Settings - Control Panel

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Prem. Semi-Gloss</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Matte</td>
</tr>
</tbody>
</table>
For this paper | Select this Paper Type setting
---|---
Epson Premium Presentation Paper Matte | Prem. Matte
Epson Ultra Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-sided
Epson High Quality Ink Jet Paper | 
Envelope | Envelope

Parent topic: Selecting the Paper Settings - Control Panel

**Selecting the Default Paper Source Settings**

You can change default paper source settings using the control panel on the product.

1. Press the home button, if necessary.
2. Select **Settings > Printer Setup**.
   
   You see a screen like this:

3. Select **Paper Source Settings** and press the OK button.
4. Select the options you want to use.
5. When you are finished, press the home button to exit.
## Paper Source Settings Options

Select the paper source options you want to use for your print jobs.

<table>
<thead>
<tr>
<th>Paper Source Settings option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Setting</td>
<td>Various</td>
<td>Select the paper size and type for each paper source</td>
</tr>
<tr>
<td>A4/Letter Auto Switching</td>
<td>On</td>
<td>Select <strong>On</strong> to switch the selected paper size to match the loaded paper (Letter or A4) if the wrong size is selected</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Error Notice</td>
<td>Paper Size Notice</td>
<td>Select <strong>On</strong> for either of these settings to display an error message when the selected paper type or size does not match the loaded paper</td>
</tr>
<tr>
<td></td>
<td>Paper Type Notice</td>
<td></td>
</tr>
<tr>
<td>Paper Setup Auto Display</td>
<td>On</td>
<td>Select <strong>On</strong> to automatically display a menu that lets you select the paper size and type when you load paper in the product.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td><strong>Note:</strong> If this setting is disabled, you cannot print using AirPrint.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting the Default Paper Source Settings
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

**Caution:** Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

**Placing Originals on the Scanner Glass**
**Placing Originals in the Automatic Document Feeder**
**ADF Original Document Specifications**

**Placing Originals on the Scanner Glass**

You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

**Note:** When originals are placed in the ADF and on the scanner glass, priority is given to the originals in the ADF.

1. Open the document cover.
2. Place your original facedown on the scanner glass with the top facing into the corner. Slide the original to the edges of the indicated corner.

Note: The edges of your original may be cropped by 0.06 inch (1.5 mm) from the edge of the scanner glass. Manually position your original away from the edges to prevent cropping.

3. Close the document cover gently to keep your original in place.

Caution: Do not push down on the document cover or scanner glass or you may damage the product.

Remove your originals after scanning. If you leave the originals on the scanner glass for a long time, they may stick to the glass surface.

Parent topic: Placing Originals on the Product
Related topics
Copying
Scanning
Faxing

---

Placing Originals in the Automatic Document Feeder

You can place single- or multi-page original documents in the Automatic Document Feeder (ADF). Make sure the originals meet the Automatic Document Feeder specifications before loading them.

Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or other materials that could obstruct the feeder.
**Caution:** Do not place photographs or valuable artwork in the ADF. Place fragile or valuable originals on the scanner glass to avoid wrinkling or damaging them.

**Note:** When originals are placed in the ADF and on the scanner glass, priority is given to the originals in the ADF.

1. Slide the ADF edge guide outward.

2. Fan your stack of originals and tap them gently on a flat surface to even the edges.

3. Insert the originals into the ADF faceup and top-edge first.
Note: Do not load originals above the arrow mark on the ADF edge guide.

The ADF icon on the Copy, Scan, and Fax screens lights up.

4. Slide the ADF edge guide against the originals, but not too tightly.

Note: If you are copying two originals onto one sheet, load the originals as shown:

Parent topic: Placing Originals on the Product
Related references
Copying Options
Related topics
Copying
Scanning
Faxing

ADF Original Document Specifications
You can load original documents that meet these specifications in the ADF.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper size</th>
<th>Paper weight</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 \times 11 \text{ inches} [216 \times 279 \text{ mm}])</td>
<td>17 to 24 lb (64 to 95 g/m²)</td>
<td>Approximately 30 sheets</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 \times 11.7 \text{ inches} [210 \times 297 \text{ mm}])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 \times 14 \text{ inches} [216 \times 356 \text{ mm}])</td>
<td></td>
<td>10 sheets</td>
</tr>
<tr>
<td></td>
<td>8.5 \times 13 \text{ inches} (216 \times 330 \text{ mm})</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Caution:** Do not load the following types of originals in the ADF, or they may be damaged or may damage the scanner. Use the scanner glass for these types of originals:

- Photos
- Thermal paper
- Originals containing tape, staples, or paper clips
- Originals with carbon paper backing
- Originals that are bound
- Originals with labels, stickers, or sticky notes
- Ripped, curled, folded, deteriorated, or wrinkled originals
- Originals with holes
- Transparencies
- Originals that are cut in an irregular shape or with corners that are not right angles

**Parent topic:** Placing Originals on the Product
Copying

See the information here to copy documents or photos using your product.

**Note:** Copies may not be exactly the same size as your originals.

Copying Documents or Photos

You can copy color or black-and-white documents or photos onto various sizes and types of paper, including Epson special papers.

1. Place your original document or photo on the scanner glass or in the ADF.
2. Load the paper you want to print on in the product.
3. Press the home button, if necessary.
4. Press the arrow buttons to select **Copy** and press the **OK** button.
   You see this screen:

![Copy screen](image)

5. To print more than one copy, press the number buttons on the numeric keypad to enter the number (up to 99).
6. Press the left or right arrow button to select one of the following:
   - **Color**: for color copies
   - **B&W**: for black-and-white copies

7. Press the **OK** button to view the print settings for the copies.
   You see this screen:

![Setting screen](image)

8. Press the down arrow button to view the individual settings.
   You see this screen:

![Setting screen](image)
9. To change the print settings, press the arrow buttons to select and adjust the necessary settings. When you are finished, press the OK button.

10. When you are ready to copy, press the start button.

   Note: To cancel copying, press the stop button.

Parent topic: Copying

Related references
Compatible Epson Papers
Copying Options
Paper Loading Capacity

Related topics
Loading Paper
Placing Originals on the Product

Copying Options
Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Print Settings

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjusts the lightness or darkness of copies</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Various settings</td>
<td>Selects the paper size</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Various settings</td>
<td>Selects the paper type</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Actual Size</td>
<td></td>
<td>Copies the original at its full size</td>
</tr>
<tr>
<td>Auto Fit</td>
<td></td>
<td>Automatically sizes the image to fit the paper size you selected</td>
</tr>
<tr>
<td>Custom 100% and</td>
<td></td>
<td>Copies the original at 100% unless you change the amount by</td>
</tr>
<tr>
<td>other conversions</td>
<td></td>
<td>adjusting the Custom Size setting.</td>
</tr>
<tr>
<td>Custom Size</td>
<td>25 - 400 in 1%</td>
<td>Adjusts the amount to re-size the original; enter the desired</td>
</tr>
<tr>
<td></td>
<td>increments</td>
<td>percentage using the numeric keypad</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Original Size</td>
<td>Various sizes</td>
<td>Select the document size of your original</td>
</tr>
<tr>
<td>Multi-Page</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Single Page</td>
<td>Copies each page of the original onto an individual sheet</td>
</tr>
<tr>
<td></td>
<td>2-up</td>
<td>Copies multiple page documents onto one sheet. Scroll down and select the document orientation and layout order settings as necessary.</td>
</tr>
<tr>
<td>Quality</td>
<td>Draft</td>
<td>Adjusts the quality of your copies</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>ID Card Copy</td>
<td>Off</td>
<td>Select <strong>On</strong> to copy both sides of an ID card onto one side of a sheet of paper</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Borderless Copy</td>
<td>Off</td>
<td>Adjusts the amount to expand the original photo when printing borderless photos</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Minimum</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Copying
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select Enable automatic checking and click OK. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing on a Mac
Printing From a Chromebook
Cancelling Printing Using a Product Button

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Basic Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows
Selecting Extended Settings - Windows
Printing Your Document or Photo - Windows
Locking Printer Settings - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options

Parent topic: Printing from a Computer
Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

You see the **Main** tab of your printer settings window:
4. Select the size of the paper you loaded as the **Document Size** setting.

   **Note:** You can also select the **User-Defined** setting to create a custom paper size, but you cannot use the **Borderless** setting and the **Quality** setting will be set to **Standard**.

5. If you are printing a borderless photo, select **Borderless**. You can click **Settings** to access additional options for borderless printing.

   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

6. Select the orientation of your document.

   **Note:** If you are printing an envelope, select **Landscape**.

7. Select the type of paper you loaded as the **Paper Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

8. Select the **Quality** setting that matches the print quality you want to use.

9. Select a Color option:

   • To print a color document or photo, select the **Color** setting.
   • To print text and graphics in black or shades of gray, select the **Black/Grayscale** setting.

10. To print on both sides of the paper, select the **2-Sided Printing** setting and select the options you want.

11. To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select one of the settings in the **Multi-Page** menu and select the printing options you want.

12. To print multiple copies and arrange their print order, select the **Copies** options.

13. To preview your job before printing, select **Print Preview**.

14. To save your print job as a project that can be modified and combined with other print jobs, select **Job Arranger Lite**.
15. To reduce noise during printing when you select **Plain Paper/Bright White Paper**, select **On** in the Quiet Mode menu.

   **Note:** Enabling **Quiet Mode** may reduce printing speed.

**Print Quality Options - Windows**

**Multi-Page Printing Options - Windows**

**Parent topic:** Printing with Windows

**Related references**

**Paper or Media Type Settings - Printing Software**

**Related tasks**

**Selecting Double-sided Printing Settings - Windows**

**Print Quality Options - Windows**

You can select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

- **Draft**
  
  For draft printing on plain paper.

- **Standard**
  
  For everyday text and image printing.

- **Standard - Vivid**
  
  For text and graphics with good quality and print speed.

- **High**
  
  For photos and graphics with high print quality.

- **More Settings**
  
  Opens a window that lets you choose among levels of speed and quality.

**Parent topic:** Selecting Basic Print Settings - Windows

**Multi-Page Printing Options - Windows**

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.

- **2-Up and 4-Up**
  
  Prints 2 or 4 pages on one sheet of paper. Click the **Page Order** button to select page layout and border options.
2×1 Poster, 2×2 Poster, 3×3 Poster, 4×4 Poster
Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main tab.

Note: You will need to print one side and flip the paper over manually to print the other side.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network.

1. Select one of the following options for 2-Sided Printing:
   - Manual (Long-edge binding) to print your double-sided print job by printing one side and prompting you to flip the paper over on the long edge to print the other side.
   - Manual (Short-edge binding) to print your double-sided print job by printing one side and prompting you to flip the paper over on the short edge to print the other side.

2. Click the Settings button.
You see a window like this:

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
5. Print a test copy of your double-sided document to test the selected settings.
6. Follow any instructions displayed on the screen during printing.

Note: The surface of the paper may smear during double-sided printing. Make sure the ink has dried before reloading the paper.

Double-sided Printing Options - Windows
Parent topic: Printing with Windows
Related tasks
Selecting Basic Print Settings - Windows
Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.

**Binding Edge Options**
Select a setting that orients double-sided print binding in the desired direction.

**Binding Margin Options**
Select options that define a wider margin to allow for binding.

**Booklet Option**
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows

Selecting Additional Layout and Print Options - Windows
You can select a variety of additional layout and printing options for your document or photo on the More Options tab.
1. To change the size of your printed document or photo, select the **Reduce/Enlarge Document** checkbox and select one of these sizing options:
   - Select the **Fit to Page** option to size your image to fit the paper you loaded. Select the size of your document or photo as the **Document Size** setting, and the size of your paper as the **Output Paper** setting. If you want to center your image on the paper, select the **Center** option.
   - Select the **Zoom to** option to reduce or enlarge your document or photo by a specific percentage. Select the percentage in the % menu.

2. Select one of the following Color Correction options:
   - Select **Automatic** to automatically adjust the sharpness, brightness, contrast, and color saturation for your image.
   - Select **Custom** and click the **Advanced** button to manually adjust the color correction settings or turn off color management in your printer software.
   - Select **Image Options** to access additional settings for improving printed images.

3. To add the following features, click the **Watermark Features** button:
   - **Anti-Copy Pattern**: adds a watermark that only appears when your printout is copied
   - **Watermark**: adds a visible watermark to your printout
   - **Header/Footer**: adds information such as the date and time to the top or bottom of your printout

   **Note**: Click the **Settings** button to customize the text and location of the header or footer.

4. Select any of the Additional Settings options to customize your print.

   - [Custom Color Correction Options - Windows](#)
   - [Image Options and Additional Settings - Windows](#)
   - [Header/Footer Settings - Windows](#)

   **Parent topic**: Printing with Windows
Custom Color Correction Options - Windows

You can select any of the available options in the Color Correction window to customize the image colors for your print job.

![Color Correction Window](image.jpg)

**Color Controls**

Lets you select a **Color Mode** setting, individual settings for **Brightness**, **Contrast**, **Saturation**, and **Density**, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the **Gamma** setting.

**Fix Photo**

Improves the color, contrast, and sharpness of flawed photos.

**Note**: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off **Fix Photo** to retain the special color effects.
ICM
Lets you manage color using installed color printing profiles.

No Color Adjustment
Turns off color management in your printer software so you can manage color using only your application software.

Parent topic: Selecting Additional Layout and Print Options - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

Image Options

**Emphasize Text**
Adjusts the weight of printed text to increase readability.

**Emphasize Thin Lines**
Adjusts the weight of printed lines to increase visibility.

**Edge Smoothing**
Smoothes jagged edges in low-resolution images such as screen captures or images from the Web.

**Fix Red-Eye**
Reduces or removes red-eye in photos.

**Print Text in Black**
Prints colored text in black.

**For Color Text**
Prints colored text on a background pattern or underlined.

**For Color Graphs and Images**
Prints colored graphics and images with overlay patterns.

**For Color Text, Graphs, and Images**
Prints colored text, graphics, and images with overlay patterns.

**Enhancement Options**
Specifies Color Universal Print enhancement settings for text, graphics, and images.

**Additional Settings Options**

**Rotate 180°**
Prints the image rotated 180° from its original orientation.
**High Speed**
Speeds up printing but may reduce print quality.

**Mirror Image**
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows

**Header/Footer Settings - Windows**
You can select any of the Header/Footer Settings options to add headers or footers when you print. The items are available to print at the top or bottom of your pages, in either the left, right, or center of the page.

**Note:** These settings are not saved with your document.

You can select to print the following information:
- User Name
- Computer Name
- Date
- Date/Time
- Document Name
- Collate Number (copy number)

**Note:** The user name, computer name, date, and time come from the Windows Control Panel on your computer.
Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or More Options tab.

**Note:** You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
You see the available **Printing Presets** on the left:

2. Place your cursor over one of the **Printing Presets** to view its list of settings.
3. Click on a preset to change its settings, or use any of the available options on the screen to control your printing presets.
4. To choose a preset for printing, select it.
5. Click **OK**.
Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
2. Select **Printer Settings**.
3. Click the **Maintenance** tab.
   
   You see the maintenance options:

4. Click the **Extended Settings** button.
You see this window:

![Extended Settings Window]

5. Select any of the extended settings to customize your print.
6. Click OK to close the Extended Settings window.
7. Click OK to close the printer software window.

Extended Settings - Windows

Parent topic: Printing with Windows

Extended Settings - Windows

You can select from these settings on the Extended Settings window.

Enable EPSON Status Monitor 3

- Enables product monitoring for ink and paper supplies and other issues.

Thick Paper and Envelopes

- Prevents ink from smearing when you print on envelopes or other thick paper.

Separator Page

- Before each document, prints a separator page containing the title, user, date, and time.

Remove white borders

- Removes white margins that may appear when you print borderless photos.
**Always Spool RAW Datatype**  
Increases print speed and may solve other printing problems.

**Page Rendering Mode**  
Increases print speed when printing is extremely slow or the print head stops during printing.

**Print as Bitmap**  
Increases print speed when printing is extremely slow or the print head stops during printing, and other settings do not help.

**Skip Blank Page**  
Ensures that your product does not print pages that contain no text or images.

**Change Standard Resolution**  
Reduces the resolution of print data to correct printing problems.

**Refine screening pattern**  
Prints graphics with a finer screening pattern.

**Allow Applications to Perform ICM Color Matching**  
Allows applications to perform ICM color matching.

**Always Use the Driver's Paper Source Setting**  
Prints using the paper source setting in the printer driver, rather than the setting in your application.

**Barcode mode**  
Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper, preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

### Printing Your Document or Photo - Windows

Once you have selected your print settings, you are ready to save your settings and print.

1. Click **OK** to save your settings.
You see your application's Print window, such as this one:

![Print window example]

2. Click OK or Print to start printing.

Parent topic: Printing with Windows

Locking Printer Settings - Windows

Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

   - **Windows 10:** Click ➤Settings ➤Devices ➤Printers & scanners. Select your product name and select Manage ➤Printer properties.
   - **Windows 8.x:** Navigate to the Apps screen and select Control Panel ➤Hardware and Sound ➤Devices and Printers. Right-click your product and select Printer properties.
   - **Windows 7:** Click ➤Devices and Printers. Right-click your product and select Printer properties.
• **Windows Vista:** Click 🌟 and select **Control Panel**. Click **Printer** under **Hardware and Sound**, then right-click your product and select **Properties**.

2. Click the **Optional Settings** tab.

   **Note:** You can prevent access to the **Optional Settings** tab by changing the user or group permissions in the **Security** tab.

3. Click **Driver Settings**.
   
   You see this window:

![Driver Settings window](image)

4. Select the checkbox for each setting you want to lock. To lock all print settings, select **All Document Settings**.

5. Under **Advanced Settings**, select the setting option you want to use for each locked setting.

6. Click **OK**.
Locked Setting Options

Parent topic: Printing with Windows

Locked Setting Options

Select the options you want to use for any locked print settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anti-Copy Pattern</td>
<td>Various data items</td>
<td>Lets you select the data to use for the pattern or prohibit anti-copy patterns</td>
</tr>
<tr>
<td>Add/Delete</td>
<td></td>
<td>Lets you add or delete a customized anti-copy pattern</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Lets you select the arrangement, size, and other settings for the custom anti-copy pattern</td>
</tr>
<tr>
<td>Watermark</td>
<td>Various text watermarks</td>
<td>Lets you select the text for the watermark or prohibit watermarks</td>
</tr>
<tr>
<td>Add/Delete</td>
<td></td>
<td>Lets you add or delete a customized text or image-based watermark</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
<td>Lets you select the size, position, and other watermark settings</td>
</tr>
<tr>
<td>Header/Footer</td>
<td>Off</td>
<td>Prohibits headers or footers</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Allows headers and footers</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Lets you select the text and position for printing headers and footers</td>
</tr>
<tr>
<td>Color</td>
<td>Color</td>
<td>Allows color printing</td>
</tr>
<tr>
<td></td>
<td>Grayscale</td>
<td>Allows printing in black or shades of gray only</td>
</tr>
<tr>
<td>Multi-Page</td>
<td>Off</td>
<td>Prohibits multi-page settings</td>
</tr>
<tr>
<td></td>
<td>2-Up</td>
<td>Allows printing of 2 pages on one sheet of paper</td>
</tr>
<tr>
<td></td>
<td>4-Up</td>
<td>Allows printing of 4 pages on one sheet of paper</td>
</tr>
</tbody>
</table>

Parent topic: Locking Printer Settings - Windows
Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.

2. Select **Printer Settings**.

   You see the printer settings window:

   ![Printer Settings Window](image)

3. Select the print settings you want to use as defaults in all your Windows programs.

4. Click **OK**.

   These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

96
Changing the Language of the Printer Software Screens

Parent topic: Printing with Windows

Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .

2. Select **Printer Settings**.
   
   You see the printer settings window.

3. Click the **Maintenance** tab.
   
   You see the maintenance options:

4. Select the language you want to use as the **Language** setting.
5. Click OK to close the printer software window. The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows

### Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select **Software Update Settings**.
   
   You see this window:

   ![Software Update Settings](image)

   3. Do one of the following:
      • To change how often the software checks for updates, select a setting in the **Check every** menu.
      • To disable the automatic update feature, select the **Never** option.

   4. Click OK to exit.

   **Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with Windows
Related tasks
Checking for Software Updates

Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your product. To print with additional settings, download and install the Epson Print and Scan utility from the Windows Store. You cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   Note: You may also need to select Properties or Preferences to view your print settings.
You see a window like this:

4. Select the type of paper you loaded as the **Media** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

5. Click the **Advanced** button.
You see a window like this:

6. Select the size of the paper you loaded as the Paper Size setting.
7. To print multiple copies, select or enter the number as the Copy Count setting.
8. To print multiple copies of multi-page documents in sets, select the Collated checkbox.
9. Click OK.
   You return to the printing preferences window.
10. Select the **Layout** tab.

11. Select the orientation of your document as the **Orientation** setting.

12. Click **OK** to save your settings.

   You see your application's **Print** window.

13. Click **OK** or **Print** to start printing.

**Parent topic:** Printing with the Built-in Epson Driver - Windows 10 S

## Printing on a Mac

You can print with your product using any Mac printing program, as described in these sections.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

**Selecting Basic Print Settings - Mac**
Selecting Basic Print Settings - Mac

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

   ![Printer selection example]

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
You see the expanded printer settings window for your product:

![Printer Settings Window](image)

**Note:** The print window may look different, depending on the Mac OS version and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing.
6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** or **Printer Features** from the pop-up menu.

You see these settings:
Note: The available print settings and appearance of the print window may be different than those covered here, depending on the Mac OS version and the application you are using.

9. Select the type of paper you loaded as the **Media Type** setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list for details.

10. Select the **Print Quality** setting you want to use.

11. Select the **Borderless** checkbox if you want to print a borderless photo. If the option is grayed out, change the **Media Type** setting to a paper type that supports borderless printing.

12. Select any of the available print options.

Print Quality Options - Mac
Print Options - Mac

Parent topic: Printing on a Mac

Related tasks
Selecting Page Setup Settings - Mac
Printing Your Document or Photo - Mac

**Print Quality Options - Mac**

You can select any of the available Print Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type setting you have chosen.

**Draft**
For draft printing on plain paper.

**Normal**
For everyday text and image printing.

**Normal - Vivid**
For everyday text and image printing with good quality and print speed.

**Fine**
For text and graphics with good quality and print speed.

**Quality**
For text and graphics with increased quality and print speed.

**High Quality**
For photos and graphics with high print quality.
**Best Quality**  
For the best print quality, but the slowest print speed.

**Parent topic:** Selecting Basic Print Settings - Mac

**Print Options - Mac**

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

**Expansion**  
If you selected a borderless paper size setting, this option adjusts the image expansion settings to control printing at the edges of borderless prints.

**Grayscale**  
Prints text and graphics in black or shades of gray.

**Mirror Image**  
Lets you flip the printed image horizontally.

**Note:** If you select the Min option for the Expansion setting, you may see white borders on your printed photo.

**Parent topic:** Selecting Basic Print Settings - Mac

**Selecting Page Setup Settings - Mac**

Depending on your application, you may be able to select the paper size and orientation settings from the print window.

![Paper Size: US Letter 8.50 by 11.00 inches](image)

**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

1. Select the size of the paper you loaded as the **Paper Size** setting. If you are printing a borderless photo, select the **Borderless** checkbox or a paper size with a **Borderless** option. You can also
select a custom setting to create a custom paper size, but the Quality setting will be limited to Normal.

**Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

**Note:** If you are printing an envelope, select the icon.

**Note:** You can reduce or enlarge the size of the printed image by selecting Paper Handling from the pop-up menu and selecting a scaling option.

Parent topic: Printing on a Mac

Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
• To print borders around each page on the sheet, select a line setting from the **Border** pop-up menu.
• To invert or flip the printed image, select the **Reverse page orientation** or **Flip horizontally** settings.

**Parent topic:** Printing on a Mac

**Managing Color - Mac**

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or turn off color management in your printer software.

1. Select **Color Matching** from the pop-up menu in the print window.

   ![Color Matching menu](image)

2. Select one of the available options.

3. Select **Color Options** from the pop-up menu in the print window.

   ![Color Options menu](image)

   **Note:** The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac

Parent topic: Printing on a Mac

Color Matching and Color Options - Mac

You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings

EPSON Color Controls

Lets you manage color using controls in your printer software or turn off color management.

ColorSync

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.

Color Options Settings

Manual Settings

Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo

Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Off (No Color Adjustment)

Turns off color management in your printer software so you can manage color using only your application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Managing Color - Mac
Selecting Printing Preferences - Mac

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select **System Preferences**.
2. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
3. Select **Driver** or **Options**.

You see a screen like this:

![Options tab screen](image)

4. Select any of the available printing preferences.
5. Click **OK**.

**Printing Preferences - Mac**

Parent topic: **Printing on a Mac**

Printing Preferences - Mac

You can select from these settings on the **Options** or **Driver** tab.
Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.

Remove white borders
Removes white margins that may appear when you print borderless photos.

Warning Notifications
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Print Settings](image)

**Checking Print Status - Mac**

**Parent topic:** Printing on a Mac

**Related tasks**

- Selecting Basic Print Settings - Mac
- Selecting Page Setup Settings - Mac
- Selecting Print Layout Options - Mac
- Managing Color - Mac
- Selecting Printing Preferences - Mac

**Checking Print Status - Mac**

During printing, you can view the progress of your print job, control printing, and check ink status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

2. Select the following options as necessary for your Mac OS version:
   • To cancel printing, click the print job and click or **Delete**.
   • To pause a print job, click the print job and click or **Hold**. To resume a print job, click the paused print job and click or **Resume**.
   • To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   • To display other printer information, click **Settings** or **Supply Levels**.

**Parent topic:** Printing Your Document or Photo - Mac

### Printing From a Chromebook

With a Google Account, you can print from a Chromebook without drivers or cables.

1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

   **Note:** See your Chromebook’s documentation for details on connecting to a network.

3. Do one of the following:
   • Click **Add to Cloud Print** in the notification that appears in the corner of your Chromebook screen.
**Note:** If you do not see a notification, check to see if a number appears in the status area at the lower-right corner of the screen. Click this number to open the notifications menu, then click **Add to Cloud Print**.

- Open a web browser and enter `chrome://devices` in the address bar. Skip to step 4.
- If you see a registration confirmation screen instead, click **Register**.

4. Click **Add Device**.
5. Click the **Register** button that appears next to your product.
6. Click **Register** on the confirmation screen. Your product's LCD screen displays a confirmation message.
7. Select **OK** or press the **OK** button on your product to confirm the Google Cloud Print connection and print a test page.
8. To print to the connected product, select the print command in your Chrome app.

Your product is now linked to your Google Account and can be accessed from any Chromebook where you are logged in, as long as you have Internet access. For more information on using Google Cloud Print and for a list of supported apps, visit the Google Cloud Print site.

**Parent topic:** Printing from a Computer

**Related topics**

- [Wi-Fi or Wired Networking](#)
- [Cancelling Printing Using a Product Button](#)

**Cancelling Printing Using a Product Button**

If you need to cancel printing, press the \( \) stop button.

**Parent topic:** Printing from a Computer
Scanning

You can scan your originals and save them as digital files.

Starting a Scan
Scanning in Epson Scan 2

Starting a Scan

After placing your originals on your product for scanning, start scanning using one of these methods.

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smart Device

Parent topic: Scanning

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel

You can scan an image to your computer using your product's control panel buttons.

Your product automatically selects default scan settings, but you can view or change them as necessary. If you are scanning to a computer, you can change the default scan settings using the Event Manager utility on the computer.

1. Make sure you installed the product software and connected the product to your computer or network.

   Note: Restart your computer after installing the product software to enable scanning from the control panel. Also make sure the Event Manager program is not being blocked by your firewall or security software.

2. Press the ⬅️ home button, if necessary.
3. Press the left or right arrow button to select Scan and press the OK button.
You see a screen like this:

![Scan interface]

4. Press the left or right arrow button to select a scan option and press the OK button.
   - **To Computer (JPEG)** saves your scan as a JPEG file on your computer or as an image capture on a Mac.
   - **To Computer (PDF)** saves your scan as a PDF file on your computer or as an image capture on a Mac.
   - **To Computer (Email)** scans your original and attaches it to a message in your e-mail program. You can select the e-mail program you want to use and resize your image, if necessary, from an option screen on your computer.

   **Note:** This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail, and Entourage, but not web-based email such as Gmail.

   - **To Computer (Custom)** saves your scan using the settings from the Event Manager utility. You can change the scanning size, destination folder, and the save format.
   - **To Computer (WSD)** lets you manage network scanning in Windows 10, Windows 8.x, Windows 7, or Windows Vista (English only). To use this feature, you must first set up a WSD (Web Services for Devices) port on your Windows 7 or Windows Vista computer (the port is set up automatically on Windows 10 and Windows 8.x).

5. Do one of the following:
   - If you are scanning to a network computer, select the target computer from the list.
   - If your product is connected directly to your computer with a USB cable, select **USB Connection**.

6. Press the start button to start scanning.

**Changing Default Scan Job Settings**
Setting Up a WSD Port (Windows 7/Windows Vista)

Parent topic: Starting a Scan

Related tasks
Changing Default Scan Job Settings

Changing Default Scan Job Settings

You can view or change the default scan job settings your product uses when you scan to your computer. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:
   - **Windows 10**: Click and select EPSON Software > Event Manager.
   - **Windows 8.x**: Navigate to the Apps screen and select Event Manager.
   - **Windows (other versions)**: Click or Start > All Programs or Programs > EPSON Software > Event Manager.
   - **Mac**: Open the Applications folder, click Epson Software, and select Event Manager.

2. Open the Scanner (Windows) or Select Scanner (Mac) drop-down list and select your product, if necessary.

3. Click Make Job Settings.

4. Open the Edit Job Settings drop-down list and select the scan job settings you want to view or change.

5. Change the settings as necessary.

   **Note:** If you create a new job, you can only assign it to the Custom Action setting. You can change the settings of the other assigned jobs, but you cannot rename them or select a different job.

6. Click OK.

7. Click Close to close the Event Manager window.

Parent topic: Starting a Scan Using the Product Control Panel

Setting Up a WSD Port (Windows 7/Windows Vista)

You can scan to a networked Windows computer using WSD (Web Services for Devices). You must first set up a WSD port on your Windows 7 or Windows Vista system (the port is set up automatically on Windows 10 and Windows 8.x).
Before you set up a WSD port, make sure you installed your product software, and connected your product and computer to the same network.

1. Turn on your product.
2. Print a network status sheet so you can identify the network name and model name for your product on the network.
3. Click or Start and select Computer.
4. On the left side of the window, select Network.
5. Locate your product on the Network screen, right-click it, and select Install.
6. When you see the User Account Control screen, click Continue.

   Note: If you see an Uninstall screen, click Uninstall and repeat these steps as necessary.

7. When you see the message Your device is ready to use in the Windows taskbar, click the message.
8. On the Driver Software Installation screen, make sure your product is listed as Ready to use. Then click Close.
9. Do one of the following:
   - Windows 7: Click and select Devices and Printers.
   - Windows Vista: Click Start and select Control Panel > Hardware and Sound > Printers.
10. Make sure that an icon appears for your product's name on the network.

When you use WSD, select your product name to scan over the network.

Parent topic: Starting a Scan Using the Product Control Panel

**Starting a Scan Using the Epson Scan 2 Icon**

You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a file.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.
• **Windows 10**: Click ☑ and select EPSON > Epson Scan 2.
• **Windows 8.x**: Navigate to the Apps screen and select Epson Scan 2.
• **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON > Epson Scan 2 > Epson Scan 2.
• **Mac**: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
You see an Epson Scan 2 window like this:
Starting a Scan from a Scanning Program

You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan, and open the scanned image in the program.

**Note:** If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

**Note:** In certain programs, you may need to select your product as the "source" first. If you see a **Select Source** option, choose it and select your product. With Windows, do not select a **WIA** option for your product; not all scan functions will be available.
You see an Epson Scan 2 window like this:
Parent topic: Starting a Scan

Starting a Scan from a Smart Device

You can start a scan from a smart device using the Epson iPrint app. You can save the scanned document to your device or a cloud service, e-mail it, or print it.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

Note: Your device must be connected to the same wireless network as your Epson product.

1. Download the Epson iPrint app from your device's app store or from Epson's website.
2. Place your original on the product for scanning.
3. Open the Epson iPrint app and select your product.
4. Select the scan settings and scan your original.
5. Save your scanned image to a file or cloud location.

Parent topic: Starting a Scan

Scanning in Epson Scan 2

Epson Scan 2 automatically scans your document and saves the scanned file in PDF format in your operating system's Documents or My Documents folder, or opens it in your scanning program. You can select settings, preview, and change the scanned file settings as necessary.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the software described in this section. You also cannot download and install any Epson product software from the Epson website for use with Windows 10 S; you must obtain software only from the Windows Store.

1. Start Epson Scan 2.
You see this window:
2. Select the **Document Source** setting that matches where you placed your original, or select **Auto Detect** to have Epson Scan 2 automatically detect the source.

3. Select the **Document Size** setting that matches the size of your original. You can select **Customize** to enter a custom size, if necessary.

4. Select the image type of your original and how you want it scanned as the **Image Type** setting.

5. Select the **Resolution** setting you want to use for your scan.

6. Select the **Rotate** setting to rotate the scanned image.

7. Select the **Correct Document Skew** setting to correct skewed originals, image contents, or both.

8. Click the **Preview** button.

   Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

9. Select any of the additional settings that you want to use on the Main Settings tab.

10. Click the **Advanced Settings** tab and select any settings that you want to use.

11. Select the format in which you want to save your scanned file as the **Image Format** setting. If necessary, select **Options** and select any desired format options.

12. Enter the file name for your scanned file in the **File Name** field. If necessary, select **Settings** to modify the file name settings.
13. Select the location in which you want to save your scanned file as the **Folder** setting. If necessary, select **Select** to create a new folder.

14. Click **Scan**.

   The product scans your original and saves the scanned file in the location you specified.

Additional Scanning Settings - Main Settings Tab

Additional Scanning Settings - Advanced Settings Tab

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2

Image Format Options

Scan Resolution Guidelines

Parent topic: Scanning

**Additional Scanning Settings - Main Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Main Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Rotate**

   Rotates the original image clockwise to the desired angle before scanning it. Select **Auto** to allow your product to automatically rotate the image based on the orientation of the text (may take longer to scan).

**Correct Document Skew**

   Corrects skewed originals, image contents, or both.

**Add or edit pages after scanning**

   Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page order.

   **Note:** To save multiple pages in a single file, you must select a file format that supports multiple pages such as **PDF** or **Multi-TIFF**. If you select another file format, each scanned image or page is saved as a separate file.

Parent topic: Scanning in Epson Scan 2

**Additional Scanning Settings - Advanced Settings Tab**

You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all adjustment settings may be available, depending on other settings you have chosen.

**Remove Background**

   Removes the background of the originals.
Text Enhancement
Sharpen the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from the graphics.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Gamma
Adjusts the midtone density of the scanned image.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Parent topic: Scanning in Epson Scan 2

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.
**Note:** The required Epson Scan 2 OCR Component is installed automatically when you install your product software as instructed on the *Start Here* sheet. If you install your scanner software programs individually, be sure to also install this component if you want to perform OCR.

1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click **Preview** and adjust the area you want to scan, if necessary.
5. If you are using the ADF, reload the ejected original.
6. Select **Searchable PDF** as the Image Format setting.
7. Select **Options** from the Image Format list.
   You see this window:

![Image Format Options window](image)

8. Select any of the options on the **General** tab.
9. Select the **Text** tab.
10. Make sure the language used in the document text is selected as the **Text Language** setting.
11. Select the Security tab if you want to add a password to the PDF or protect printing or editing properties.

12. Click OK.

13. Confirm the File Name setting and select a Folder setting for your document.

14. Click Scan.

The scanned image is saved as a searchable PDF.

Parent topic: Scanning in Epson Scan 2

Image Format Options

You can select different image formats and related options. For details on available options, click the ? icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.

BITMAP (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The TIFF format is recommended when you need to modify or retouch your scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.

Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned document can be searched.

Parent topic: Scanning in Epson Scan 2
Scan Resolution Guidelines

The Resolution setting, measured in dpi (dots per inch), controls the amount of detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes with the following disadvantages:

• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan 2. Follow these guidelines to determine the resolution setting you need:

• You will scan the image at its original size but enlarge it later in an image-editing program.
  Increase the Epson Scan 2 Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.
• You will scan the image at 100% or smaller size.
  Select the Epson Scan 2 Resolution setting based on how you will use the scanned image:
  • Email/view on a computer screen/post on the web: 96 to 200 dpi
  • Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

Parent topic: Scanning in Epson Scan 2
Faxing

See these sections to fax using your product.

**Note:** This product allows you to store names, telephone numbers, and fax data in its memory even when the power is turned off. Make sure you restore all of the default settings if you give away or dispose of the product. This will erase all of your network settings and fax data.

Connecting a Telephone or Answering Machine
Setting Up Fax Features
Setting Up Contacts and Contact Groups
Sending Faxes
Receiving Faxes
Checking Fax Status
Printing Fax Reports

**Connecting a Telephone or Answering Machine**

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the same telephone line to receive calls, you can connect a telephone or answering machine to your product using an additional phone cable.

**Note:** If you do not connect a telephone to your product, make sure Receive Mode is set to **Auto**. Otherwise, you cannot receive faxes.
1. Connect a phone cable to your telephone wall jack and to the **LINE** port on your product.

**Note:** If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your product. Contact your DSL or ISDN provider for the necessary equipment.
2. If you are connecting a telephone or answering machine to your product using a second phone cable, remove the cap from the EXT port on your product.

3. Connect a second phone cable to your telephone or answering machine and to the EXT port on your product.
Note: If you connect an answering machine and Receive Mode is set to Auto, set the number of rings before your product answers a call to a number that is higher than your answering machine's setting for the number of rings.

Any phone or answering machine must be connected to the EXT port for your product to detect an incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VoIP, cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing
Related references
Basic Settings - Fax

Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and time settings for faxes.

Setting Up Basic Fax Features
Selecting Advanced Fax Settings
Setting Up the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac
Parent topic: Faxing
Related tasks
Receiving Faxes Automatically

Setting Up Basic Fax Features

See these sections to select the basic settings you need to use the product's fax features.

Using the Fax Setting Wizard
Selecting the Line Type
Setting the Number of Rings to Answer
Parent topic: Setting Up Fax Features
Using the Fax Setting Wizard

You can setup the product's basic fax settings using the Fax Setting Wizard. This wizard is automatically displayed when the product is turned on for the first time. You can also change these settings individually from the Fax Settings menu.

1. Press the home button, if necessary.
2. Select Settings and press the OK button.

3. Select Fax Settings and press the OK button.
4. Select Fax Setting Wizard and press the OK button.
   The Fax Setting Wizard screen appears.
5. Press the OK button to proceed.
6. On the Enter Fax Header screen, use the numeric keypad to enter the sender name for your fax source, such as your name or a business name, then press the OK button. You can enter up to 40 characters.

![Enter Fax Header screen]

7. On the Your Phone Number screen, use the numeric keypad to enter your fax number, up to 20 characters.

**Note:** The name and phone number in the fax header identifies the source of the faxes you send.

8. On the DRD Setting screen, do one of the following:
   - If you have subscribed to a distinctive ring service from your telephone company, press the OK button. Select the ring pattern to be used for incoming faxes, press the OK button, and skip to step 12.
   - If you have subscribed to a distinctive ring service from your telephone company, press the OK button. Select **All** and press the OK button.
   - If you do not have a distinctive ring service, press the # button to skip.

**Note:** Distinctive ring services allow you to have several phone numbers on one phone line. Each number is assigned a different ring pattern. You can use one number for voice calls and another for fax calls. Select the ring pattern assigned to fax calls in the Distinctive Ring setting. If you select a ring pattern other than **All**, **Receive Mode** is automatically set to **Auto**.
9. On the Receive Mode Setting screen, confirm whether you are using a telephone connected to the product:

![Receive Mode Setting]

- If you are using a telephone, press the **OK** button.
- If you are not using a telephone, press the **stop** button and skip to step 11. **Receive Mode** is set to **Auto**.

10. Do one of the following:

   - Press the **OK** button if you want to receive faxes automatically. **Receive Mode** is set to **Auto**.
   - Press the **stop** button if you want to receive faxes manually. **Receive Mode** is set to **Manual**.

11. On the confirmation screen, check the settings and press the **OK** button to proceed.

![Confirmation]

12. On the Check Fax Connection screen, press the **OK** button and follow the on-screen instructions to check the fax connection and print a report of the check result. If there are any errors reported, try the solutions on the report and run the check again.

If the Select Line Type screen appears, select the correct line type.
If the option to disable dial tone detection appears, press the OK button. However, disabling the dial tone detection function may drop the first digit of a fax number and send the fax to the wrong number.

13. Press the # button to exit the Fax Setting Wizard.

**Parent topic:** Setting Up Basic Fax Features

### Selecting the Line Type

If you connect the product to a PBX phone system or terminal adapter, you must change the product's line type. PBX (Private Branch Exchange) is used in office environments where an external access code such as “9” must be dialed to call an outside line. The default Line Type setting is PSTN (Public Switched Telephone Network), which is a standard home phone line.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings > Basic Settings > Line Type > PBX.
   
   You see a screen like this:

   ![Access Code Screen](image)

3. Select Use and press the OK button to activate the setting.
4. Use the numeric keypad to enter the access code, such as 9, and press the OK button.

**Parent topic:** Setting Up Basic Fax Features

### Setting the Number of Rings to Answer

If you connect an external answering machine and select to receive faxes automatically, make sure the Rings to Answer setting is correct. The number of rings should be higher than the number of rings your answering machine is set to for answering a call.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings > Basic Settings > Rings to Answer.

3. Enter the number of rings and press the OK button. Make sure to select a number higher than the number of rings your answering machine is set to for answering a call.

   **Note:** An answering machine picks up every call faster than the product, but the product can detect fax tones and start receiving faxes. If you answer the phone and hear a fax tone, check that the product has started receiving the fax, then hang up the phone.

**Parent topic:** Setting Up Basic Fax Features

**Selecting Advanced Fax Settings**

You can select a variety of advanced fax settings.

1. Press the home button, if necessary.
2. Select Settings > Fax Settings.

   You see a screen like this:
3. Select the group of settings you want to change.

Receive Settings - Fax
Basic Settings - Fax
Report Settings - Fax
Security Settings - Fax

Parent topic: Setting Up Fax Features

Receive Settings - Fax

Set the print options you want to use for incoming faxes in the Receive Settings menu.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save to Computer</td>
<td>No</td>
<td>Select to print out received faxes without saving them as PDFs on the computer connected to the product.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Select to save received faxes as PDFs on a computer connected to the product. Yes can only be selected from the connected computer by using the FAX Utility.</td>
</tr>
<tr>
<td></td>
<td>Yes and Print</td>
<td>Select to print out and save the received faxes as PDFs on a computer connected to the product. Yes and Print can only be selected from the control panel after the setting has been changed to Yes from the FAX Utility.</td>
</tr>
<tr>
<td>Auto Reduction</td>
<td>On</td>
<td>Select to reduce the size of large received faxes to fit on the paper size in the selected paper source.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Select to print large incoming faxes at their original size on multiple sheets, if necessary.</td>
</tr>
<tr>
<td>Split Page Settings</td>
<td>Delete Print Data After Split</td>
<td>Select how to split large incoming faxes across multiple sheets.</td>
</tr>
<tr>
<td></td>
<td>Overlap When Split</td>
<td></td>
</tr>
<tr>
<td>Auto Rotation</td>
<td>On</td>
<td>If you have loaded A5-size paper, select On to rotate landscape-oriented incoming faxes so that they print correctly on the paper.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Reception Information</td>
<td>On</td>
<td>Select <strong>On</strong> to include the date, time, the sender's information, and a page number in the header of your incoming faxes.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Start Timing</td>
<td>All Pages Received</td>
<td>Select to print incoming faxes after the product receives all of the pages of the document.</td>
</tr>
<tr>
<td></td>
<td>First Page Received</td>
<td>Select to print incoming faxes as soon as the product receives the first page of the document.</td>
</tr>
<tr>
<td>Collation Stack</td>
<td>On</td>
<td>Select <strong>On</strong> to print incoming faxes so that the pages are stacked in the correct page order. (When the product is low on memory, this option may not be available.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Print Suspend Time</td>
<td>Off</td>
<td>Select <strong>On</strong> to set a time period to stop automatic printing of faxes or reports and save received faxes in the product's memory. (Make sure there is enough free memory before using this function.)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Quiet Mode</td>
<td>On</td>
<td>Select <strong>On</strong> to reduce noise during printing. (Printing speed may be reduced.)</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Basic Settings - Fax

Set the basic options you want to use for incoming and outgoing faxes.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Speed</td>
<td>Fast(33,600bps)</td>
<td>Sets the speed at which you send and receive faxes.</td>
</tr>
<tr>
<td></td>
<td>Medium(14,400bps)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Slow(9,600bps)</td>
<td></td>
</tr>
<tr>
<td>ECM</td>
<td>On</td>
<td>Turns on Error Correction Mode (ECM) to automatically correct errors in sent or received fax data.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off Error Correction Mode (ECM); color faxes cannot be sent or received.</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dial Tone Detection</td>
<td>On</td>
<td>Automatically dials the number you enter for faxing when the product detects a dial tone.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic dial tone detection, which may be necessary if the product is connected to a PBX (Private Branch Exchange) or a TA (Terminal Adapter). However, turning this setting off may cause the product to drop the first digit of a fax number.</td>
</tr>
<tr>
<td>Line Type</td>
<td>PSTN</td>
<td>Selects a standard phone line (Public Switched Telephone Network).</td>
</tr>
<tr>
<td></td>
<td>PBX</td>
<td>Selects Private Branch Exchange, the type of phone line used in office environments where an access code such as 9 must be used to call an outside line.</td>
</tr>
<tr>
<td>Header</td>
<td>Your Phone Number</td>
<td>Select to enter the header information and your phone number for inclusion on outgoing faxes.</td>
</tr>
<tr>
<td></td>
<td>Fax Header</td>
<td></td>
</tr>
<tr>
<td>Receive Mode</td>
<td>Manual</td>
<td>Lets you confirm whether an incoming fax should be printed; a telephone must be connected to the product.</td>
</tr>
<tr>
<td></td>
<td>Auto</td>
<td>Automatically receives and prints faxes.</td>
</tr>
<tr>
<td>Distinctive Ring</td>
<td>All</td>
<td>If you are using a Distinctive Ring Service on your phone line, your telephone company can assign two or more phone numbers to the same line and assign different ring patterns to each. If you use this service, select the number of rings for your fax number so your product can receive faxes on the correct number of rings. Select All for phones lines that do not use this service.</td>
</tr>
<tr>
<td></td>
<td>Single</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Triple</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Double&amp;Triple</td>
<td></td>
</tr>
<tr>
<td>Rings to Answer</td>
<td>1 to 9</td>
<td>Sets the number of rings before your product receives a fax. If Receive Mode is set to Auto and an answering machine is connected to the product, make sure this setting is set higher than the number of rings your answering machine is set to answer a call.</td>
</tr>
</tbody>
</table>
### Setting Options Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Receive</td>
<td>Off</td>
<td>Lets you start receiving faxes using your phone instead of operating the product (if Receive Mode is set to Auto). When you select On, you must also set a start code. If you are using a cordless handset with its base connected to the product, you can start receiving the fax by entering the code using the handset.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Rejection Fax</td>
<td>Various</td>
<td>Lets you automatically reject faxes received from blocked numbers, unrecognized contacts, or with blank headers.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

### Report Settings - Fax

Select the options you want to use for fax reports.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Log Auto Print</td>
<td>Off</td>
<td>Does not print a fax log.</td>
</tr>
<tr>
<td></td>
<td>On(Every 30)</td>
<td>Prints a fax log after every 30 fax jobs are completed.</td>
</tr>
<tr>
<td></td>
<td>On(Time)</td>
<td>Prints a fax log at a specified time. If the number of completed fax jobs exceeds 30, the fax log prints before the specified time.</td>
</tr>
<tr>
<td>Attach Fax image to report</td>
<td>Off</td>
<td>Does not include an image on the Transmission Report.</td>
</tr>
<tr>
<td></td>
<td>On(Large Image)</td>
<td>Prints a Transmission Report that includes the upper part of the first page of the sent document.</td>
</tr>
<tr>
<td></td>
<td>On(Small Image)</td>
<td>Prints a Transmission Report that includes a reduced size of the entire first page of the sent document.</td>
</tr>
<tr>
<td>Report Format</td>
<td>Simple</td>
<td>Prints a simple fax report.</td>
</tr>
<tr>
<td></td>
<td>Detail</td>
<td>Prints a fax report that includes error codes.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings
Security Settings - Fax

Set the security options you want to use for fax data.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Dialing</td>
<td>Off</td>
<td>Does not restrict dialed fax numbers.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>On</td>
<td>Allows faxing only to numbers stored in the contacts list or history.</td>
</tr>
<tr>
<td>Enter Twice</td>
<td></td>
<td>Requires you to enter fax numbers twice to prevent errors.</td>
</tr>
<tr>
<td>Confirm Address List</td>
<td>Off</td>
<td>Selects whether or not to display a recipient confirmation screen before a fax is sent.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Backup Data Auto</td>
<td>Off</td>
<td>Automatically erases sent or received fax data from your product's memory.</td>
</tr>
<tr>
<td>Clear Backup Data</td>
<td>—</td>
<td>Deletes all sent or received fax data remaining in your product's memory; run this function if you are giving away or disposing of your product.</td>
</tr>
</tbody>
</table>

Parent topic: Selecting Advanced Fax Settings

Setting Up the Fax Utility - Windows

You can set up the FAX Utility for Windows for use with your product.

**Note:** Before using the FAX Utility for Windows, make sure you have set up the fax features on your product using the product control panel. Also first confirm that you can send and receive faxes using the control panel.

1. Do one of the following:
   - **Windows 10:** Click 📦 and select EPSON Software.
   - **Windows 8.x:** Navigate to the Apps screen.
   - **Windows (other versions):** Click 📦 or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Return to the main window** at the bottom of the window.
4. Click **Select Printer** and follow the on-screen instructions to transfer your product's fax settings to the FAX Utility.

   **Note:** For detailed information, click **Help** or **Open Online Help**.

**Parent topic:** Setting Up Fax Features

### Setting Up Fax Features Using the Fax Utility - Mac

You can set up your fax header and select your fax settings using the FAX Utility for Mac.
1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select the **FAX** option for your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Double-click **FAX Utility**, if necessary.

You see this window:

![FAX Utility window](image)

3. Select your **FAX** product in the Printer list.

4. Select **Fax Settings**.

5. Follow the prompts that appear on the screen to enter your fax header information and select your fax settings.

   **Note:** For detailed information, select the **FAX Utility ?** icon.

Parent topic: Setting Up Fax Features

### Setting Up Contacts and Contact Groups

You can set up a list of contacts and their fax numbers so you can quickly select them for faxing. You can also set up contact groups to send a fax message to multiple contacts.

**Setting Up Contacts Using the Product Control Panel**

**Importing Contacts Using the Fax Utility - Windows**

**Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac**
Parent topic: Faxing

Setting Up Contacts Using the Product Control Panel

You can set up your contacts and contact groups using the control panel on your product.

Creating a Contact
Creating a Contact Group
Editing or Deleting a Contact or Group

Parent topic: Setting Up Contacts and Contact Groups

Creating a Contact

You can create a list of contacts to save frequently used fax numbers.

Note: You can create up to 100 contacts and contact groups combined.

1. Press the home button, if necessary.
2. Select Settings > Contacts Manager.
   You see a screen like this:

   ![Contacts Manager screen](image)

3. Select Add Entry and press the OK button.
4. Select the registry number you wish to assign the contact and press the OK button.
You see this screen:

5. Use the numeric keypad to enter the contact name (up to 30 characters) and press the OK button.
6. Use the numeric keypad to enter a word to use when searching for an entry (up to 30 characters), and press the OK button. (This field is optional.)
7. Use the numeric keypad to enter the fax number and press the OK button. You can enter up to 64 characters.
   
   Note: If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the Line Type setting, enter the # pound sign instead of the code.
8. Select a communication mode setting and press the OK button.
9. Check the details and press the stop button to make any changes. Otherwise, press the OK button to add the entry.
Parent topic: Setting Up Contacts Using the Product Control Panel

Creating a Contact Group

You can create a group of contacts so that you can easily send faxes to multiple recipients.

Note: You can create up to 100 contacts and contact groups combined. You must create a contact before creating a contact group.

1. Press the home button, if necessary.
2. Select Settings > Contacts Manager.
   You see a screen like this:
   
   ![Contacts Manager Screen]
   
   3. Select Add Group and press the OK button.
   You see a screen like this:
   
   ![Select Registry Num Screen]
   
   4. Select the registry number you wish to assign to the group and press the OK button.
5. Use the numeric keypad to enter the group name (up to 30 characters), and press the OK button.

6. Use the numeric keypad to enter a word to use when searching for a group (up to 30 characters), and press the OK button. (This field is optional.)

   You see your contacts list.

7. Select the contacts you want to include and press the right arrow button on each to include them in your group.

   **Note:** To display the contacts in alphabetical order, press the left arrow button.

   A check mark appears next to each selected contact.

8. Press the OK button.

9. Review the details and press the stop button to make corrections. Otherwise, press the OK button to add the entry.

**Parent topic:** Setting Up Contacts Using the Product Control Panel

### Editing or Deleting a Contact or Group

You can edit or delete any of the contacts or groups on your list.

1. Press the home button, if necessary.

2. Select **Settings > Contacts Manager**.
You see a screen like this:

3. Do one of the following:
   • To edit a contact or group, select **Edit** then select the entry you want to edit. Enter the correct information and press the **OK** button on the Details screen to add the entry.
   • To delete a contact or group, select **Delete** then select the entry you want to delete. Press the **OK** button. Press it again on the confirmation screen.

Parent topic: Setting Up Contacts Using the Product Control Panel

Importing Contacts Using the Fax Utility - Windows

You can edit contacts stored in your product and import contacts from your Windows Address Book to the PC-FAX Phone Book in the FAX Utility for Windows.

1. Do one of the following:
   • **Windows 10**: Click and select **EPSON Software**.
   • **Windows 8.x**: Navigate to the **Apps** screen.
   • **Windows (other versions)**: Click or **Start > Programs** or **All Programs** > **EPSON Software**.

2. Select **FAX Utility**.
The first time you use the FAX Utility, you see this introduction window:

3. Read about the FAX Utility and click **Return to the main window** at the bottom of the window.
You see this window:

4. To edit the contacts list on your product, click **Contacts**.
5. Do one of the following:
   - To edit a contact, select it in the list and click the icon.
   - To delete a contact, select it in the list and click the icon.
6. To import fax numbers from your Windows Address Book into the FAX Utility PC-FAX Phone Book, select **Edit PC-FAX Phone Book**.
You see this window:

7. Select File > Import From Windows Address Book.
8. Select the contacts you want to import and click OK.

   Note: For detailed information, select Help or Open Online Help.

Parent topic: Setting Up Contacts and Contact Groups
Related topics
Setting Up Contacts Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

   Note: You can create up to 60 speed dial and group dial entries combined.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select the FAX option for your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
2. Double-click FAX Utility, if necessary.
3. Select your **FAX** product in the Printer list.
4. Select **Speed Dial/Group Dial List**.
   You see this window:
5. To add an entry, double-click an empty entry.

   **Note:** To edit an entry, select it and change the information. To delete an entry, select it and press the **Delete** key on your keyboard.

6. Do one of the following:
   - To create a speed dial entry, select **Speed Dial**, enter a name and fax number, and click **OK**.
   - To create a group dial entry, select **Group Dial**, enter a name, select your desired fax numbers, and click **OK**.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.

8. To import entries from your MacAddress book, click the icon.

9. When you are finished, click the icon to save the entries to your product's memory.

**Parent topic:** Setting Up Contacts and Contact Groups

**Related topics**

Setting Up Contacts Using the Product Control Panel

---

**Sending Faxes**

See these sections to send faxes using your product.

- Sending Faxes from the Product Control Panel
- Sending Faxes Using the Fax Utility - Windows
- Sending Faxes Using the Fax Utility - Mac
- Dialing Fax Numbers from a Connected Telephone

**Parent topic:** Faxing

---

**Sending Faxes from the Product Control Panel**

See these sections to send faxes using the product's control panel.

- Sending a Fax Using the Keypad, Contact List, or History
- Fax Sending Options
- Sending a Fax at a Specified Time

**Parent topic:** Sending Faxes

**Related tasks**

Selecting the Line Type
Related topics
Setting Up Contacts Using the Product Control Panel
Placing Originals on the Product

Sending a Fax Using the Keypad, Contact List, or History
You can send a fax from your product control panel by entering the fax number, or selecting the number from either the contact list or fax history.

**Note:** Depending on the product's available memory, you can fax up to 100 pages at a time, including a cover sheet. You can send a black-and-white fax to up to 100 contacts or 99 groups at a time, or send a color fax to one recipient at a time. If your recipient's fax machine does not print in color, your fax is automatically sent in black-and-white.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax and press the OK button.
   
   ![Fax screen]
   
   You see a screen like this:

4. Do one of the following to select fax recipients:
   
   - **Manually enter a fax number:** Enter a fax number using the numeric keypad, and press the OK button when done. To add another fax number, repeat this step; the number of multiple recipients appears in the upper right corner of the LCD screen.

   **Note:** If direct dialing has been restricted, you can only select the number from the contact list or fax history. If necessary, enter an outside line access code (such as 9) at the beginning of the fax number. If the access code has been set up in the Line Type setting, enter the # pound sign
instead of the code. If your fax number requires a brief pause, press the down arrow button to insert a pause symbol (–).

- **Select from the contact list:** Press the up arrow button to display the contact list. Use the up arrow and **OK** buttons to select one or more contacts (select the contact again to deselect it), and press the ➡️ back button to close the contact list.

- **Select from the sent fax history:** Press the down arrow button to display the sent fax history. Use the arrow and **OK** buttons to select a recipient from the list.

  **Note:** To delete selected recipients, press the right arrow button. Select the recipients you want to delete and press the **OK** button on each. When you are finished, press the ➡️ back button.

5. If you need to change any fax settings, press the **OK** button and select **Scan Settings** or **Fax Send Settings** and select your settings.

6. Press the ✼ start button to send the fax.

   **Note:** To cancel faxing, press the ⚪ stop button.

Your product scans your original and prompts you to place additional pages, if necessary. After scanning your originals, your product dials the number and sends the fax.

**Note:** If the fax number is busy or there is a problem, the product automatically redials after one minute. While the product is sending a color fax, other features are unavailable.

**Parent topic:** Sending Faxes from the Product Control Panel

**Fax Sending Options**

While sending a fax, you can select **Scan Settings** and **Fax Send Settings** and select these options.

**Scan Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td><strong>Standard</strong></td>
<td>Adjusts the scan resolution and print quality of outgoing faxes</td>
</tr>
<tr>
<td></td>
<td><strong>Fine</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Photo</strong></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Density</td>
<td>Varying levels available</td>
<td>Lets you select from various density levels</td>
</tr>
<tr>
<td>ADF Continuous Scan</td>
<td>Off</td>
<td>Select <strong>On</strong> to have the product to ask if you want to scan another page after a document in the ADF has finished scanning</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Original Size (Glass)</td>
<td>Half Letter</td>
<td>Sets the size for a document placed on the scanner glass</td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>Color Mode</td>
<td>B&amp;W</td>
<td>Select whether to scan images in color or black and white</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td></td>
</tr>
</tbody>
</table>

**Fax Send Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Send</td>
<td>Off</td>
<td>Select <strong>On</strong> to send black-and-white faxes to a single recipient as soon as the connection is made, without saving the scanned image to memory. You cannot use this setting when sending a color fax or sending a fax to multiple recipients.</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Send Fax Later</td>
<td>Off</td>
<td>Select <strong>On</strong> to send the current fax at a selected time</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>Add Sender Info</td>
<td>Off</td>
<td>Lets you include a header, your phone number, or a destination list in the selected location on your outgoing faxes</td>
</tr>
<tr>
<td></td>
<td>Outside of Image</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Inside of Image</td>
<td></td>
</tr>
<tr>
<td>Fax Header</td>
<td>—</td>
<td>Displays your fax header information</td>
</tr>
<tr>
<td>Additional Header Info</td>
<td>—</td>
<td>Indicates the other information included in your fax header</td>
</tr>
<tr>
<td>Setting</td>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Transmission Report</td>
<td>Print on Error</td>
<td>Lets you select when to print transmission reports</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Do Not Print</td>
<td></td>
</tr>
</tbody>
</table>

**Setting Options**

**Parent topic:** Sending Faxes from the Product Control Panel

**Sending a Fax at a Specified Time**

You can send a fax at a time of your choice. You can only schedule one fax at a time.

**Note:** Make sure the product's date and time settings are correct. You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the home button, if necessary.
3. Select Fax and press the OK button.
   
You see a screen like this:

![Fax interface screenshot]

4. Use the numeric keypad to enter a fax number or select a number from the Contacts or Recent list.
5. Press the **OK** button to open the Fax menu.

6. Select **Fax Send Settings** and press the **OK** button.
7. Select **Send Fax Later** and press the **OK** button.
8. Select **On** and press the **OK** button.
9. Use the numeric keypad, and the arrow and reset buttons, to enter your desired time. Then press the **OK** button.
10. Press the back button twice to return to the Fax screen.
11. Press the start button to send the fax.

   **Note:** To cancel faxing, press the stop button.

After scanning your originals, your product dials the number and sends the fax at the specified time.

**Note:** If the product is turned off at the specified time, the fax is sent when you turn it back on.

**Parent topic:** Sending Faxes from the Product Control Panel

**Related topics**

- Setting Up Contacts and Contact Groups
- Placing Originals on the Product

**Sending Faxes Using the Fax Utility - Windows**

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time, including a cover sheet.
1. Open the file you want to fax and select the print command. You see a window like this:

![Print window](image)

2. Select your product with the **FAX** option as the printer.

3. To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the **Preferences** or **Properties** button, change the necessary settings, and click **OK**.

   **Note:** If you see a **Setup**, **Printer**, or **Options** button, click it. Then click **Preferences** or **Properties** on the next screen. For more information about selecting fax print settings, click **Help**.

4. Select the **Page Range** as necessary. (Leave the **Number of copies** set to 1.)

5. Click **Print** or **OK**.
If you’re faxing for the first time, you see a window like this one:

![Enter Sender Information window](image)

6. Enter your sender information so that recipients can identify the origin of the fax. Then click **OK** to save the sender information.
You see a window like this:

7. Enter the recipient's name and fax number or select a recipient from the phonebook, then click **Next**.

   **Note:** For detailed instructions on using the Epson FAX Utility, click **Help**.

8. Select a cover sheet and enter a subject and message, then click **Next**.
9. Click **Send** to transmit your fax.

**Parent topic:** Sending Faxes

**Sending Faxes Using the Fax Utility - Mac**

You can send a fax from a Mac printing program using the FAX Utility. You can fax up to 100 pages at a time, including a cover sheet.

1. Open the file you want to fax.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the **File** menu, or another command. See your application's help utility for details.

![Printer settings](image)

3. Select your product **FAX** option as the **Printer** setting.
4. If necessary, click the arrow next to the **Printer** setting or the **Show Details** button to expand the print window.
5. Select the number of pages you are faxing as the **Pages** setting.

   **Note:** Leave the **Copies** setting set to 1.

6. Select **Recipient Settings** from the pop-up menu.
7. Do one of the following to choose your recipient:
   • Select a name or group from the Recipient List.
   • Enter a name, company, and fax number and click the + button.
   • Click the icon and select a recipient from your address book.
8. Select Fax Settings from the pop-up menu.
You see this window:

You see this window:

9. Select the **Color** and **Image Quality** settings you want to use for your fax.
10. Click **Fax**.

**Parent topic:** Sending Faxes

Dialing Fax Numbers from a Connected Telephone

If you connected a telephone to the **EXT** port on your product, you can send a fax by dialing the fax number from the connected telephone. If the recipient’s phone number and fax number are the same, you can speak to the recipient before sending the fax.

**Note:** When a fax number is dialed using the connected telephone, sending a fax takes longer because the product scans and sends the fax simultaneously. While sending the fax, other features cannot be used.

1. Place your original on the product for faxing.

   **Note:** Depending on the product’s available memory, you can fax up to 100 pages at a time, including a cover sheet.

2. Press the home button, if necessary.
3. Dial the fax number from the connected telephone. Speak to the recipient if necessary.

   **Note:** If you are using a pre-paid calling card, enter the number and password required to use the card before entering the destination fax number.

4. Select **Fax** on the LCD screen and press the **OK** button.

5. Press the **OK** button, select **Scan Settings** or **Fax Send Settings**, and select any settings as necessary.

   **Note:** Your product now communicates with the recipient's fax machine. Do not hang up the telephone.

6. When you hear a fax tone, press the ◇ start button to start sending the fax.

   **Note:** If your recipient's fax machine does not print in color, your fax is automatically sent in black-and-white.

7. Hang up the telephone.

**Parent topic:** Sending Faxes

### Receiving Faxes

See these sections to receive faxes with your product.

- **Fax Reception**
- **Receiving Faxes Automatically**
- **Receiving Faxes Manually**
- **Receiving a Fax by Polling**
- **Selecting Received Fax Options Using the Fax Utility - Windows**

**Parent topic:** Faxing

### Fax Reception

Your product will automatically receive and print faxes when you set the Receive Mode to **Auto**.

If you connected a telephone to your product so you can use the same phone line for faxes and voice calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.
Note: If you run out of paper during fax printing, load more paper and press the button indicated on your product’s LCD screen to continue.

Parent topic: Receiving Faxes

**Receiving Faxes Automatically**

To receive faxes automatically, make sure **Receive Mode** is set to **Auto** (the default setting for the product).

To change the **Receive Mode** if necessary, select **Settings > Fax Settings > Basic Settings > Receive Mode**.

If an answering machine is connected, make sure the product’s **Rings to Answer** setting is set higher than the number of rings your answering machine is set to answer a call. For example, if the answering machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

Parent topic: Receiving Faxes

Related tasks

Receiving Faxes Manually

**Receiving Faxes Manually**

You can set up your product to receive faxes manually by setting the **Receive Mode** to **Manual**. This lets you check for a fax tone on the connected telephone before receiving a fax.

1. To change the **Receive Mode** setting, from the home screen, select **Settings > Fax Settings > Basic Settings > Receive Mode** and select **Manual**.
2. When the connected telephone rings, answer the call.
3. If you hear a fax tone, select **Fax** on the LCD display.

   **Note:** To receive a fax using the attached telephone instead of the product control panel, enable the **Fax Settings > Basic Settings > Remote Receive** setting.

4. Press the # button.
5. Press the ⦿ start button to start receiving the fax.
6. Hang up the telephone.

Parent topic: Receiving Faxes
Receiving a Fax by Polling

You can use polling to receive a fax from another fax machine (such as a fax information service).

**Note:** You cannot use polling to receive a fax from a fax information service that uses audio guidance.

1. Press the home button, if necessary.
2. Select Fax and press the OK button.
   You see a screen like this:

   ![Fax screen](image)

3. Press the OK button, select More, and press the OK button.
   ![More screen](image)

4. Select Polling Receive and press the OK button.
5. Select **On** and press the **OK** button.

6. Use the numeric keypad to enter the fax number you expect to receive the fax from.

7. Press the ✉️ start button to start receiving the fax.

**Parent topic:** Receiving Faxes

### Selecting Received Fax Options Using the Fax Utility - Windows

You can select options for use with received faxes using the FAX Utility for Windows.

1. Do one of the following:
   - **Windows 10:** Click 📴 and select **EPSON Software**.
   - **Windows 8.x:** Navigate to the **Apps** screen.
   - **Windows (other versions):** Click 📥 or **Start > Programs or All Programs > EPSON Software**.

2. Select **FAX Utility**.

   The first time you use the FAX Utility, you see this introduction window:
3. Read about the FAX Utility and click **Close** at the bottom of the window.
   You see this window:

![FAX Utility window](image)

4. To save faxes received by your product on your computer, select **Save received faxes on this computer**.
5. Select the destination folder and other options, and click **OK**.
   You return to the FAX Utility window.
6. To receive notifications when received faxes arrive in the selected destination folder on your computer, select **Notify me if new faxes exist in forwarding folders**.
7. Select how often you want to be notified of received faxes and click OK.

Note: For detailed information, click Help or Open Online Help.

Parent topic: Receiving Faxes

Checking Fax Status
You can check the status of current fax jobs, or faxes that have been received or sent on the product control panel.

1. Press the home button, if necessary.
2. Select Fax.
   You see a screen like this:

   ![Fax Status Screen]

3. Press the OK button, select More, then press the OK button.
4. Select Transmission Log and press the OK button. Select the fax job you want to check.
   
   Note: If you see the received fax light is flashing, received faxes have been temporarily saved to the product's memory.

Parent topic: Faxing

Printing Fax Reports
You can print several types of fax reports whenever necessary.

1. Press the home button, if necessary.
2. Select **Fax** and press the **OK** button.
   You see a screen like this:

![Fax Screen]

3. Press the **OK** button, select **More**, and press the **OK** button.
4. Select **Fax Report** and press the **OK** button.
5. Select the fax report you want to print and press the **OK** button.

**Fax Report Options**

**Parent topic:** Faxing

### Fax Report Options

Select the fax report or list you want to print.

**Last Transmission**

- Print a report on the previous fax that was sent or received through polling.

**Fax Log**

- View or print a report on recent fax transmissions. You can use the **Settings > Fax Settings > Report Settings > Fax Log Auto Print** setting to print the report automatically.

**Fax Settings List**

- Print a list of the current fax communication settings.

**Protocol Trace**

- Print a detailed report for the previous sent or received fax.

**Parent topic:** Printing Fax Reports
Refilling Ink

When the ink level is below the lower line on an ink tank, you need to refill it. Periodically check the ink tanks to see if they need to be refilled. Before checking the ink levels or refilling an ink tank as described here, be sure to read the ink safety precautions.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank. Continued use of the product when the ink level is below the lower line on a tank could damage the product.

Ink Safety Precautions
Check Ink Levels
Purchase Epson Ink
Refilling the Ink Tanks

Ink Safety Precautions

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate inaccurate messages if the ink tanks are not refilled according to these instructions.

As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below the lower line. Continued use of the product when the ink level is below the lower line on the tank could damage the product.

Ink Handling Precautions

• Keep ink bottles and the ink tanks out of the reach of children. Do not allow children to drink from or handle the ink bottles and bottle caps.
• Do not tilt or shake an ink bottle after opening it; otherwise, ink may leak.
• If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or problems persist, see a doctor immediately. If ink gets into your mouth, spit it out and see a doctor right away.
• Do not squeeze the ink bottles.
• If ink spills, wipe it up immediately. To prevent the ink from spreading, blot the spill with a dry cloth, then wipe it with a damp cloth. The ink will be hard to remove once it has dried.

**Ink Refilling Precautions**

• Use ink bottles with the correct part number for this product.

• The use of non-Epson ink may cause damage that is not covered by Epson’s warranty, and under certain circumstances, may cause erratic product behavior.

• This product requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled with ink. If ink gets on your clothes or belongings, it may not come off.

• Do not open the ink bottle package until you are ready to fill an ink tank. Ink bottles are vacuum packed to maintain reliability. If you leave an ink bottle unpacked for a long time before using it, print quality may be affected.

• If the ink level is below the lower line on an ink tank, refill the ink. Continued use of the product when the ink level is below the lower line on an ink tank could damage the product.

• Visually check the ink levels in the product’s ink tanks to confirm the actual ink levels. Continued use of the product when the ink is expended could damage the product.

• Epson recommends filling all ink tanks to the upper line when the product is not operating to reset the ink levels.

• For optimum printing results, refill the ink tanks to the upper line at least once a year.

• After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

• Use the ink bottle before the date printed on the package.

• After opening an ink bottle, Epson recommends using it as soon as possible.

• Wipe off any ink around the tanks and ports with a clean, lint-free cloth or cotton swab.

• Store ink bottles in a cool, dark place.

• Do not store the ink bottles in high or freezing temperatures.

• Store the ink bottles in the same environment as the product. When storing or transporting an opened ink bottle, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking when you transport the bottle.
Ink Bottle and Ink Tank Information

- To maintain optimum print head performance, some ink is consumed from all ink tanks during printing and when performing maintenance operations, such as cleaning the print head. Ink may also be consumed when the product is turned on.
- The ink bottles may contain recycled materials, but this does not affect product function or performance.
- When printing in monochrome or grayscale, color ink may be used instead of black ink, depending on the paper type or print quality settings. This is because a mixture of color inks is used to create black.
- A reserve amount of ink remains in the tank when your product indicates that a refill is necessary.

Parent topic: Refilling Ink

Check Ink Levels

To confirm the actual ink remaining, visually check the ink levels in the product’s ink tanks. Make sure the ink levels are above the lower lines on the ink tanks.

Caution: If the ink level is below the lower line on the ink tank, fill it to the upper line on the ink tank. Continued use of the product when the ink level is below the lower line on a tank could damage the product.

Checking Ink Levels on Your Product
Checking Ink Levels - Windows
Checking Ink Levels - Mac
Disabling Special Offers with Windows

Parent topic: Refilling Ink
Checking Ink Levels on Your Product

To confirm the actual ink levels, visually check the ink levels in the product’s ink tanks. Make sure the ink levels are above the lower lines on the ink tanks.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate inaccurate messages if the ink tanks are not refilled according to these instructions.

As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below the lower line. Continued use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Check Ink Levels

Related tasks
Refilling the Ink Tanks

Checking Ink Levels - Windows

A low ink reminder appears if you try to print when ink is low, and you can check your ink levels at any time using a utility on your Windows computer.

1. To check your ink levels, access the Windows Desktop and double-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and double-click.
You see a window like this:

![EPSON Status Monitor 3 window](image)

2. Refill any ink tank as needed.

   **Note:** The ink levels displayed are an estimate and may differ from the actual ink remaining in the ink tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks. Continued use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Check Ink Levels

Related tasks
Refilling the Ink Tanks
Checking Ink Levels - Mac

You can check your ink levels using a utility on your Mac.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Select EPSON Status Monitor.

   You see a window like this:

   ![EPSON Status Monitor](image)

   3. Refill any ink tank as needed.

   **Note:** To update or refresh the displayed ink levels, click Update.

   **Note:** The ink levels displayed are an estimate and may differ from the actual ink remaining in the ink tanks. To confirm the actual remaining ink, visually check the ink levels in the ink tanks. Continued use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Check Ink Levels
Related tasks
Refilling the Ink Tanks

Disabling Special Offers with Windows
You can disable special offers messages from Epson using a utility on your Windows computer.

Note: You may see the Epson Special Offers screen every time you print (if your computer is connected to the Internet). Select Do not display this message again and click Decline to disable online offers. Promotional offers are not valid in Latin America.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click. Select Monitoring Preferences.
You see this window:

2. To disable promotional offers, deselect the Display Epson Offers checkbox.

Parent topic: Check Ink Levels

Purchase Epson Ink
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit epson.com.jm or call your nearest Epson sales office.
Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not specified for this printer could cause damage not covered by Epson's warranties.

The ink bottles that are used for initial product setup have a lower yield due to the ink charging process. This process is carried out the first time you turn on the printer and guarantees better performance. Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do not load paper before refilling the ink tanks.

Check the ink levels in your product frequently, and refill the ink tanks if necessary.

Ink Bottle Part Numbers

Parent topic: Refilling Ink

Ink Bottle Part Numbers

Use these part numbers when you order or purchase new ink bottles.

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>544</td>
</tr>
<tr>
<td>Yellow</td>
<td>544</td>
</tr>
<tr>
<td>Magenta</td>
<td>544</td>
</tr>
<tr>
<td>Cyan</td>
<td>544</td>
</tr>
</tbody>
</table>

Parent topic: Purchase Epson Ink

Refilling the Ink Tanks

Make sure you have new ink bottles handy and have read the ink safety precautions before you begin.

You can continue to use the product even if one or more ink tanks are not filled all the way. However, for the most accurate ink level monitoring, fill all the ink tanks up to the top line.

Note: The product has a low ink alert system. The accuracy of this system depends on the user refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate inaccurate messages if the ink tanks are not refilled according to these instructions.

As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below the lower line. Continued use of the product when the ink level is below the lower line on the tank could damage the product.
Caution: Wear disposable gloves while refilling the ink tanks to avoid staining your hands. If ink spills, wipe it off immediately with a damp towel to avoid permanent stains. If ink gets on your clothes or belongings, it may not come off.

1. Turn on your product.
2. Use the arrow buttons to select **Maintenance** and press the **OK** button.
3. Select **Reset Ink Level** and press the **OK** button.
   You see this screen:

![Reset ink level screen](image)

4. Open the ink tank cover.
5. Open the cap for the ink tank you are going to fill.

   **Note:** Make sure the color of the ink tank matches the ink color you want to refill.

![Illustration of a printer and ink bottle]

6. Hold the ink bottle upright and slowly turn the bottle cap to remove it.

   **Caution:** Do not shake or squeeze the bottle. Do not touch the top of the bottle after its cap is removed. Do not allow the top of the ink bottle to hit any objects after removing its cap; otherwise, ink may spill.

   **Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If discomfort or problems persist, see a doctor immediately. If ink gets into your mouth, spit it out and see a doctor right away. Keep the ink bottles out of the reach of children and do not drink the ink.
7. Position the top of the ink bottle along the slot in front of the filling port, then slowly stand the bottle up to insert it.

![Image of ink bottle being inserted]

**Note:** Refer to the color-coded sticker on the ink tank unit to identify the color of each tank. Do not force the bottles into position; they are keyed for each color.

8. Wait for the ink to fill the tank. Do not squeeze the bottle. Ink flows into the tank and stops automatically when the ink is filled to the upper line.

![Image of ink tank filling]

**Note:** If ink does not flow from the bottle, lift and reinsert the bottle.
9. When the ink tank is full, remove the ink bottle and securely close the ink tank cap.

![Image of ink tank](image)

**Note:** If any ink remains in the bottle, replace the bottle cap and tighten it. Store the bottle upright for later use.

10. Repeat the previous steps as necessary for each ink tank you need to refill.

11. Close the ink tank cover firmly.

![Image of ink tank cover](image)

12. Press the start button.

13. Follow the on-screen instructions to reset the ink level for the colors you refilled.

**Parent topic:** Refilling Ink

**Related concepts**

**Purchase Epson Ink**
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head. If running these utilities does not solve the problem, you may need to run a Power Cleaning or clean the paper path.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide
Checking the Number of Sheets

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You may not be able to clean the print head when the ink level in any of the tanks is low. You may have to refill the ink tank first.

If you still see white or dark lines or gaps in your printouts, even after cleaning the print head several times, you can run a Power Cleaning.

Print Head Nozzle Check
Print Head Cleaning
Power Cleaning

Parent topic: Adjusting Print Quality
Related tasks
Refilling the Ink Tanks

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

190
Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.

5. Press the OK button again to select Nozzle Check.
6. Press the start button to print. The nozzle check pattern is printed.

7. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean]

   **Print head needs cleaning**

   ![Print head needs cleaning]

8. Do one of the following:
   - If there are no gaps, the print head is clean. Select **No** and press the **OK** button.
   - If there are gaps or the pattern is faint, select **Yes** and press the **OK** button. Follow the instructions on the screen to clean the print head.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.

**Parent topic:** Print Head Nozzle Check

**Related tasks**

- [Cleaning the Print Head Using the Product Control Panel](#)
- [Refilling the Ink Tanks](#)

**Related topics**

- [Loading Paper](#)
Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click.
   • **Mac**: In the Apple menu or the Dock, select **System Preferences**, Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
4. Select **Nozzle Check**.
   You see a window like this:
5. Click **Print**.
6. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean image]

   **Print head needs cleaning**

   ![Print head needs cleaning image]

7. If there are no gaps, click **Finish**.
   
   If there are gaps or the pattern is faint, clean the print head.

**Parent topic:** Print Head Nozzle Check

**Related tasks**

- Cleaning the Print Head Using a Computer Utility
- Refilling the Ink Tanks

**Related topics**

- Loading Paper

---

### Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You may not be able to clean the print head when the ink level in any of the tanks is low. You may have to refill the ink tank first.
Cleaning the Print Head Using the Product Control Panel

Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related tasks

Refilling the Ink Tanks

Cleaning the Print Head Using the Product Control Panel

You can clean the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Maintenance and press the OK button.
5. Select **Head Cleaning** and press the **OK** button.

6. Press the \( \bigcirc \) start button to clean the print head.

   **Caution:** Never open the inner cover or turn off the product during a cleaning cycle or you may damage it.

   You see a message on the LCD screen and the \( \bigcirc \) power light flashes throughout the cleaning cycle. When the cleaning cycle is finished, the \( \bigcirc \) power light stays on and you see a message on the LCD screen.

7. Select **Nozzle Check**, press the **OK** button, and press the \( \bigcirc \) start button to run a nozzle check and confirm that the print head is clean.

   If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait at least 12 hours. Then run a nozzle check and try cleaning the print head again. If quality still does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.

**Parent topic:** Print Head Cleaning

**Related references**

Where to Get Help

**Related tasks**

Checking the Nozzles Using the Product Control Panel

Refilling the Ink Tanks
Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility

You can clean the print head using a utility on your Windows or Mac computer.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
   • **Mac**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
4. Select **Head Cleaning**.
You see a window like this:

5. Click **Start** to begin the cleaning cycle.
   
   You see a message on the computer screen during the cleaning cycle. The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is finished.

   **Caution:** Never open the inner cover or turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.
7. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Pattern image]

   **Print head needs cleaning**

   ![Pattern image]

   - If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 3 times, turn off the product and wait at least 12 hours. Then check the print head nozzles and try cleaning the print head again. If quality still does not improve, run a Power Cleaning. If there is still no improvement, contact Epson support.

**Parent topic:** Print Head Cleaning

**Related references**

Where to Get Help

**Related tasks**

Refilling the Ink Tanks

**Related topics**

Loading Paper

---

**Power Cleaning**

If you still see white or dark lines or missing nozzles in your printouts, even after cleaning the print head several times, you can run a Power Cleaning.
If you do not see improvement after running a Power Cleaning, turn off the product and wait at least 12 hours before running another Power Cleaning.

**Caution:** Running a Power Cleaning consumes a lot of ink, so you should run it only if necessary. Make sure each ink tank is at least one-third full before running a Power Cleaning, or it may damage the product.

**Caution:** Power Cleaning may cause the ink pads to reach their capacity sooner. When an ink pad reaches the end of its service life, the product stops printing and you must contact Epson for support.

**Power Cleaning Using the Product Control Panel**

**Power Cleaning Using a Computer Utility**

**Parent topic:** Print Head Maintenance

---

**Power Cleaning Using the Product Control Panel**

You can run a Power Cleaning using the control panel on your product.

**Note:** After a Power Cleaning, you must turn off the product and wait at least 12 hours before running another Power Cleaning.

1. Turn off the product.
2. Visually check the ink levels and make sure each ink tank is at least one-third full.
   **Caution:** If you run a Power Cleaning when the ink levels are low, you may damage the product.
3. Press and hold the ⌘ power button and the help button at the same time until you see the Power Cleaning screen.
4. Follow the instructions on the LCD screen to run the Power Cleaning.
5. When the Power Cleaning is finished, run a nozzle check.

If the print quality did not improve, turn off the product and wait at least 12 hours before running another Power Cleaning.

If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson for support.

**Parent topic:** Power Cleaning

**Related tasks**

* Refilling the Ink Tanks
Power Cleaning Using a Computer Utility

You can run a Power Cleaning using a utility on your Windows or Mac computer.

**Note:** After running a Power Cleaning, you must turn off the product and wait at least 12 hours before running another Power Cleaning.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   - **Windows:** Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click . Select **Printer Settings** and click the **Maintenance** tab.
   - **Mac:** In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
4. Select **Power Cleaning**.
You see a window like this:

5. Follow the on-screen instructions to run a Power Cleaning.
6. When Power Cleaning is finished, run a nozzle check.

If the print quality did not improve, turn off the product and wait at least 12 hours before running another Power Cleaning.

If the print quality does not improve after running the Power Cleaning utility multiple times, contact Epson for support.

Parent topic: Power Cleaning
Related tasks
Refilling the Ink Tanks
Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to align the print head.

**Note:** Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel

Parent topic: Adjusting Print Quality

### Aligning the Print Head Using the Product Control Panel

You can align the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen and the output tray is extended.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select **Maintenance** and press the **OK** button.
5. Select **Print Head Alignment** and press the **OK** button.
6. Do one of the following:
   - Select **Vertical Alignment** and press the **OK** button.
   - Select **Horizontal Alignment** and press the **OK** button.
7. Press the start button to print an alignment sheet.

   **Note:** Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and use the arrow and **OK** buttons to select the number representing the most solid printed pattern for each set on the LCD screen.

   **Vertical Alignment**

   ![Vertical Alignment Pattern]

   **Horizontal Alignment**

   ![Horizontal Alignment Pattern]

9. Press the **OK** button when you are finished.

**Parent topic:** Print Head Alignment

**Related topics**

Loading Paper

Cleaning the Paper Guide

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.

**Caution:** Do not use tissues to clean the inside of the product. You can damage the product.

1. If printouts are smeared or scuffed, load plain paper in this size: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).
2. Select **Maintenance**.

---

204
You see a screen like this:

3. Select **Paper Guide Cleaning** and press the **OK** button.
4. Follow the on-screen instructions to clean the paper guide.
5. Repeat these steps as necessary until the paper comes out clean.

**Parent topic:** Adjusting Print Quality

**Related concepts**
- Print Head Alignment
- Print Head Cleaning

**Related tasks**
- Cleaning the Print Head Using a Computer Utility

### Checking the Number of Sheets

You can view an option that displays the number of sheets of paper that have fed through the product.

**Note:** You can also view the number of sheets of paper fed through the product by printing a nozzle check.

- Checking the Sheet Counter - Windows
- Checking the Sheet Counter - Mac

**Parent topic:** Adjusting Print Quality
Checking the Sheet Counter - Windows

You can check the number of sheets of paper that have fed through the product by checking the sheet counter.

1. Access the Windows Desktop and right-click the icon for your product in the right side of the Windows taskbar, or click the up arrow and right-click .
2. Select Printer Settings.
3. Click the Maintenance tab.
4. Select Printer and Option Information.
   You see this window:

   ![Image of Printer and Option Information window]

5. After checking the number of sheets fed into the printer, click OK to close the window.

   **Note:** The number of sheets is displayed only when Epson Status Monitor 3 is enabled.

**Parent topic:** Checking the Number of Sheets
Checking the Sheet Counter - Mac

You can check the number of sheets of paper that have fed through the product by checking the sheet counter.

1. In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Select **Printer and Option Information**.

You see this window:

3. After checking the number of sheets fed into the printer, click **OK** to close the window.

**Parent topic:** Checking the Number of Sheets
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

**Caution:** Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Open the document cover.
6. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a little glass cleaner.

**Caution:** Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.

7. Close the document cover.

8. Open the ADF cover.

9. Use a soft, moistened, lint-free cloth (microfiber is recommended) to clean the rollers and the interior of the ADF.

**Caution:** Using a dry cloth may damage the surface of the rollers. Let the rollers dry before using the ADF.
10. Close the ADF cover.
11. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it some distance, prepare it for transportation as described here.

Caution: During transportation and storage, follow these guidelines:
- Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

- Place the product in a plastic bag and fold the bag closed.
- When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink may leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking when transporting the ink bottles.
- Do not put opened ink bottles in the box with the product.
• Before transporting the product, make sure that the print head is in the home (far right) position.
  1. Turn off the product.
  2. Remove all the paper and any originals from the product.
  3. Make sure the ⬤ power light turns off, then unplug the power cable.
  4. Disconnect any connected cables.
  5. Open the ink tank cover and make sure that the ink tank caps are installed securely.

6. Close the ink tank cover securely.
7. Close the paper support and output tray, then lower the control panel by gently pushing it down.

211
8. Place the product in its original packaging materials, if possible, or use equivalent cushioning around the product.

If print quality has declined when you print again, clean and align the print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Product Status Messages
Message Appears Prompting You to Reset Ink Levels
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Faxing Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

It's a good idea to check Epson's support website occasionally for free updates to your product software. Visit epson.com.jm/support and select your product.

- **Windows**: Your printer software automatically checks for updates. You can also manually update the software by selecting **Software Update** here:
  - Accessing the Windows Desktop and right-clicking the icon for your product in the right side of the Windows taskbar, or clicking the up arrow and right-clicking .
  - On the **Maintenance** tab in the printer settings window

You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.
• **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

• **macOS 10.12.x or later**: You can manually update the software by opening the **App Store**, selecting **Updates**, searching for a software update option for Epson Software, and selecting **Update**.

**Parent topic:** Solving Problems

### Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen.

**Note**: If the LCD screen is dark, press any button on the control panel to wake the product from sleep mode.

<table>
<thead>
<tr>
<th>LCD code</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>(E-01)</td>
<td>A printer error has occurred. Turn the product off and then back on again. If the error continues, check for a paper jam. If there is no paper jam, contact Epson for support.</td>
</tr>
<tr>
<td>(E-02)</td>
<td>A scanner error has occurred. Turn the product off and then back on again.</td>
</tr>
<tr>
<td>(E-11)</td>
<td>The ink pad needs to be replaced. Contact Epson for support. Non-printing features such as scanning are still available.</td>
</tr>
<tr>
<td>(E-12)</td>
<td>A borderless printing ink pad needs to be replaced. Contact Epson for support. Borderless printing is not available, but printing with a border is available.</td>
</tr>
<tr>
<td>(W-01)</td>
<td>Paper is jammed in the product. Remove the jammed paper, then press the button indicated on the LCD screen to clear the error. If the error continues, turn the product off and back on again.</td>
</tr>
<tr>
<td>(W-11)</td>
<td>An ink pad is nearing the end of its service life. Contact Epson for support. (To continue printing, press the start button.)</td>
</tr>
<tr>
<td>(W-14)</td>
<td>A borderless printing ink pad is nearing the end of its service life. Contact Epson for support. (To continue printing, press the start button.)</td>
</tr>
<tr>
<td>(I-22)</td>
<td>To establish a wireless connection using a router or access point, press the button on the router or access point, or click the button on its wireless settings screen displayed on your computer.</td>
</tr>
<tr>
<td>(I-23)</td>
<td>Enter the PIN code displayed on the LCD screen into the router, access point, or computer within two minutes. If you wait longer than two minutes, a time-out error occurs, the code changes, and you must enter a new code.</td>
</tr>
<tr>
<td>LCD code</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(I-31)</td>
<td>To make wireless connection settings from your computer, run the installer and follow the on-screen instructions.</td>
</tr>
<tr>
<td>(I-41)</td>
<td>The Paper Setup Auto Display option is disabled. You must enable Paper Setup Auto Display to use AirPrint.</td>
</tr>
<tr>
<td>(I-60)</td>
<td>Your computer may not support WSD (Web Services for Devices). The Scan to PC (WSD) function is available only for computers running English versions of Windows 10, Windows 8.x, Windows 7, or Windows Vista. Make sure your product is connected correctly to the computer.</td>
</tr>
<tr>
<td></td>
<td>Recovery Mode</td>
</tr>
<tr>
<td></td>
<td>A firmware update has failed. Connect your product using a USB cable and try updating the firmware again. If you still receive this error message, contact Epson for support.</td>
</tr>
</tbody>
</table>

**Note:** The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages. During the life of your product it may reach a condition where either satisfactory print quality cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your LCD screen, or lights on the control panel will advise you when these parts need replacing. If this happens during the standard warranty of the product, the exchange of the product or replacement of the pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems

Related references
- Where to Get Help

Related tasks
- Checking for Software Updates
- Connecting a Telephone or Answering Machine

Related topics
- Loading Paper
- Solving Paper Problems
- Wi-Fi or Wired Networking
Message Appears Prompting You to Reset Ink Levels

If you see a message on the LCD screen prompting you to reset the ink levels, do the following:

1. Refill all of the ink tanks or the ink tanks indicated on the LCD screen all the way to the top.

   **Note:** Depending on the operating conditions, you may see the ink reset message even when there is still ink in the tanks.

2. Select the colors that you refilled on the LCD screen.

3. Follow the instructions on the LCD screen to reset the ink levels.

   **Note:** The product has a low ink alert system. The accuracy of this system depends on the user refilling the ink tanks correctly. The product cannot directly measure the ink levels in the tanks; instead it estimates the amount of ink remaining by internally monitoring ink usage. The low ink alert system may generate inaccurate messages if the ink tanks are not refilled according to these instructions.

   As a precaution, perform regular visual inspections of the ink tanks to ensure ink levels do not fall below the lower line. Continued use of the product when the ink level is below the lower line on the tank could damage the product.

Parent topic: Solving Problems

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select **Maintenance** and press the OK button.

![Maintenance Menu](image)

5. Select **Nozzle Check** and press the OK button.

![Nozzle Check Menu](image)

6. Press the ⚫ start button.

   The nozzle check pattern is printed.

7. Do one of the following, depending on the results of the product check:
   - If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check other solutions or try uninstalling and reinstalling your printer software.
• If the page prints but the nozzle check pattern has gaps, clean or align the print head.
• If the page does not print, the product may have a problem. Check other solutions. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts
Print Head Cleaning
Print Head Alignment
Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

1. Press the home button, if necessary.
2. Select Settings and press the OK button.
3. Select Restore Default Settings and press the OK button.

4. Select one of these options and press the OK button:
   • Network Settings: Resets all network settings.
• **Copy Settings**: Resets all copy settings.
• **Scan Settings**: Resets all scan settings.
• **Fax Settings**: Resets all fax settings.
• **Clear All Data and Settings**: Resets all settings.

You see a confirmation screen.

5. Press the **OK** button to reset the selected settings. (Press the **stop** button if you want to cancel the operation.)

**Parent topic**: Solving Problems

---

**Solving Setup Problems**

Check these sections if you have problems while setting up your product.

Product Does Not Turn On or Off

- Noise After Filling the Ink
- Software Installation Problems
- Control Panel Setup Problems

**Parent topic**: Solving Problems

---

**Product Does Not Turn On or Off**

If you cannot turn the product on or off, try these solutions:

- If you cannot turn on your product, make sure the power cord is securely connected and hold down the power button a little longer.

- If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off your product, unplug the power cord, plug the power cord back in, then turn your product on and off again using the power button.

**Parent topic**: Solving Setup Problems

---

**Noise After Filling the Ink**

If you hear noises from your product after filling the ink tanks with ink, check these explanations:

- The first time you fill the tanks with ink, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on. Your product is finished charging the print head when the **power** light stops flashing.
• If the product's print head stops moving or making noise, and the charging process has not finished after approximately 20 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems

If you have problems while installing your product software, try these solutions:

• Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions on the Start Here sheet. Also make sure your system meets the requirements for your operating system.

• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your system administrator.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Control Panel Setup Problems

If you have problems setting up the control panel, try these solutions:

• To view LCD screen text in a different language, select a different language setting for the panel.

• To adjust the position of the control panel, carefully raise or lower it.

Parent topic: Solving Setup Problems

Related tasks
Adjusting Control Panel Sounds
Changing LCD Screen Language
Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

**Note:** Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your fax and network data and settings.

**Product Cannot Connect to a Wireless Router or Access Point**

Network Software Cannot Find Product on a Network

Product Does Not Appear in Mac Printer Window

Wireless Network Connection is Unstable on a Mac

Wired Network Connection Becomes Unstable

Cannot Print Over a Network

Cannot Scan Over a Network

Parent topic: Solving Problems

**Product Cannot Connect to a Wireless Router or Access Point**

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

- Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

- Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

- Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

• Try restarting your router following the instructions in your router documentation.

  **Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product's MAC address to your router’s address list. To obtain your product’s MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

• If you cannot connect your product to a device using Wi-Fi Direct, you may have exceeded the maximum number of devices connected to your product (8). Print a network status sheet or access Web Config on the browser for your device and check the number of connected devices. If 8 devices are already connected, disconnect a device by deleting the product’s SSID from the Wi-Fi screen of that device. If fewer than 8 devices are connected, check the accuracy of your other network settings, move your device closer to your product, and try connecting again.

**Parent topic:** Solving Network Problems

**Related concepts**

Wi-Fi Direct Mode Setup

**Related tasks**

Printing a Network Status Sheet

Printing a Network Connection Report

Disabling Wi-Fi Features

**Related topics**

Wi-Fi or Wired Networking
Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify the connection using your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.

• Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.

• Make sure your product is not connected to a guest network.

• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product’s network settings to their factory defaults.
  2. **Windows only**: Uninstall your product software.
  3. Restart your router following the instructions in your router documentation.

  **Note**: If you are reading these instructions online, you will lose your Internet connection when you restart your router, so note the next step before restarting it.

  4. Download your product software from the Epson website using the instructions on the *Start Here* sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

  **Note**: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing detection of your device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

**Parent topic**: Solving Network Problems

**Related concepts**

Uninstall Your Product Software
Product Does Not Appear in Mac Printer Window

If your product does not appear in the Mac printer window, try these solutions:

• Turn your product off, wait 30 seconds, then turn it back on again.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your product's LCD screen is not lit, make sure you select one of the WPS options from the product control panel within 2 minutes of pressing the WPS button on your router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Wireless Network Connection is Unstable on a Mac

If you connected a device to a USB 3.0 port on your Mac, you may experience wireless network interference between your product and your Mac.

If you cannot connect to your product over the wireless network or the connection becomes unstable, move the device connected to your Mac USB 3.0 port further away from your Mac.

Parent topic: Solving Network Problems

Wired Network Connection Becomes Unstable

When you connect the product to a wired network using a router or access point that supports IEEE 802.3az (Energy Efficient Ethernet), the connection may become unstable, you may be unable to connect to the product, and the communication speed may become slow. If you experience any of these issues, follow the steps below to disable IEEE 802.3az and then connect your product again.

1. Disconnect the Ethernet cables connected to the computer and your product.

2. Disable IEEE 802.3az for the computer's network adapter if it is enabled (check your operating system's Ethernet connection settings).
3. Connect the computer and your product directly with an Ethernet cable.
4. Print a network connection report from your product.
5. On the computer, open a web browser and enter your product's IP address from the network connection report.
6. Select Advanced Settings > Network Settings > Wired LAN.
7. Select OFF for IEEE 802.3az. and click Next.
8. Click OK and remove the Ethernet cable connecting the computer and your product.
9. If you disabled IEEE 802.3az for your computer's network adapter, enable it.
10. Reconnect the Ethernet cables from the router or access point to your computer and product. If problems still occur, other devices on the network may be causing them.

Parent topic: Solving Network Problems
Related tasks
Printing a Network Connection Report

Cannot Print Over a Network

If you cannot print over a network, try these solutions:

- Make sure that your product is turned on.
- Make sure you install your product's network software as described in your product documentation.
- Print a network status sheet and verify that the network settings are correct. If the network status is Disconnected, check any cable connections and turn your product off and then on again.
- Print a network connection report and check the codes and messages on the report to help determine the cause of the problem.
- If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
- Make sure your computer and product are both using the same wireless network.
- If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Try restarting your router following the instructions in your router documentation.

  **Note:** If you are reading these instructions online, you will lose your Internet connection when you restart your router.

• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product wirelessly via EpsonNet Setup and the Wi-Fi connection icon is not lit or does not appear on the product's LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic:** Solving Network Problems

**Related references**

- Cannot Scan Over a Network

**Related tasks**

- Printing a Network Status Sheet

**Related topics**

- Wi-Fi or Wired Networking

---

**Cannot Scan Over a Network**

If you cannot start Epson Scan 2 for scanning over a network, try these solutions:

• If you cannot scan from your product control panel, make sure you restarted your computer after installing the product software. Make sure the Event Manager program is not being blocked by your firewall or security software.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band, give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

• Check the scanning setting assigned in Epson Event Manager.
• If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few seconds, and restart it. If Epson Scan 2 cannot restart, turn off your product, turn it back on, and try restarting Epson Scan 2 again.

• Check the scanner setting and reset the connection if necessary using Epson Scan 2 Utility:

  Windows 10: Click [start] and select EPSON > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other tab and click Reset.

  Windows 8.x: Navigate to the Apps screen, select EPSON, and select Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other tab and click Reset.

  Windows (other versions): Click [Start] > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other tab and click Reset.

  Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make sure your product is selected. If necessary, select the Other tab and click Reset.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

Parent topic: Solving Network Problems
Related tasks
Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan 2 Icon

Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
• Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Product Makes Noise When It Sits for a While
Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Paper Jams Inside the Product
Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:
• Place the product on a flat surface.
• If paper does not feed for printing, remove it. Then reload it in the middle of the rear paper feed. Slide the edge guides against the edge of the paper, making sure that the paper stack is not above the arrow mark on the edge guides.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• If multiple pages feed at once during manual 2-sided printing, remove any paper from the product before reloading paper.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• Make sure your paper meets the specifications for your product.
• Make sure the paper size and paper type settings on the control panel are correct.
For best results, follow these guidelines:
- Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
- Load paper in the rear paper feed printable side up.
- Follow any special loading instructions that came with the paper.
- When loading originals in the ADF, load them in the correct direction and not above the arrow on the ADF edge guide. Load only originals supported by the ADF and be sure to slide the ADF edge guide against the edge of the originals. Check that the ADF icon appears on the Copy, Scan, or Fax screen; if not, remove and replace the originals.
- Clean the inside of the ADF.

Parent topic: Solving Paper Problems

Related references
Paper Specifications
Paper Jams Inside the Product

Paper Jams Inside the Product
If you see a message that paper has jammed in the product, follow the on-screen instructions to locate and remove the jammed paper.

Take the following precautions when removing jammed paper from the product:
- Remove the jammed paper carefully. Using too much force may damage the product.
- Unless specifically instructed, avoid tilting the product, placing it on its side, or turning it upside down, as ink may spill.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the product starts operating, it may cause an injury. Do not touch any protruding parts inside the product.

Parent topic: Solving Paper Problems

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
- If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.
- If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.
Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

- Make sure your product is turned on and connected to your computer.
- Make sure any interface cables are connected securely at both ends.
- If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
- Make sure the printer status is not offline or pending.
- Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. Print the image at a lower resolution or if necessary, increase your system's memory.
- In Windows, make sure your product is selected as the default printer and the printer port setting matches the printer connection port.
• In Windows, delete all jobs from the Windows Spooler. Click **Print Queue** on the Maintenance tab in the printer settings window, and cancel any stalled print jobs.

• On a Mac, make sure the printer is added to the printer list and the printer is not paused.

**Parent topic:** [Solving Problems Printing from a Computer](#)

**Related tasks**

Running a Product Check

---

**Product Icon Does Not Appear in Windows Taskbar**

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:

   • **Windows 10:** Click 
     ![Windows 10 Settings icon](image)
     and select > > > . Select your product name and select > .
   
   • **Windows 8.x:** Navigate to the screen and select > > . Right-click your product name, select , and select your product name again if necessary.

   • **Windows 7:** Click and select . Right-click your product name, select , and select your product name again if necessary.

   • **Windows Vista:** Click , select , and click under .
     Right-click your product name, select , and select your product name again if necessary.

2. Click the **Maintenance** tab.

3. Click the **Extended Settings** button.

4. Select **Enable EPSON Status Monitor 3** and click **OK**.

5. Click the **Monitoring Preferences** button.

6. Click the checkbox for the option that adds the shortcut icon to the taskbar.

7. Click **OK** to close the open program windows.

**Parent topic:** [Solving Problems Printing from a Computer](#)
Printing is Slow

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.
- If you are using Windows 7, close the Devices and Printers window before you print.
- On a Mac, make sure you download and install the Epson printer driver.
- Make sure Quiet Mode is turned off.
- Clear space on your hard drive or run a defragmentation utility to free up existing space.
- Close any programs you are not using when you print.
- If your product is connected to a USB hub, connect it directly to your computer instead.
- If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

- Make sure the paper type setting matches the type of paper you loaded.
- Turn on any high speed settings in your product software.
- Select a lower print quality setting.

**Windows:** Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress, and select the following settings:

- Always Spool RAW Datatype
- Page Rendering Mode
- Print as Bitmap

**Windows:** Select Printer Properties, click the More Options tab, and make sure the High Speed setting is enabled.

**Mac:** Select System Preferences, select Printers & Scanners, and select your product. Select Options & Supplies, select Options (or Driver), and enable the High Speed Printing setting.

If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click and select Computer or My Computer. Double-click the C: drive and open these folders: ProgramData > EPSON > PRINTER.
Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and search options. In the window that appears, click the View tab, select Show hidden files, folders, and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.

Parent topic: Solving Problems Printing from a Computer

Related references
Paper or Media Type Settings - Printing Software
Windows System Requirements
Mac System Requirements

Related tasks
Selecting Basic Print Settings - Windows
Selecting Extended Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Printing Preferences - Mac

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems
Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

- Turn off any mirror or inversion settings in your printing application.
- Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Mac
Selecting Additional Layout and Print Options - Windows

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple copies.

Parent topic: Solving Page Layout and Content Problems

Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the Skip Blank Page setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.
- You may need to refill the ink. Visually check the ink levels.

Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Cleaning
Print Head Nozzle Check

Related references
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel
Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- Make sure you selected the correct margins for your paper size in your printing program.
- Make sure your paper is positioned correctly for feeding into the product.
- When placing originals on the scanner glass, align the corner of the original with the corner indicated by the arrow. If the edges of the copy are cropped, move the original slightly away from the corner.
- Clean the scanner glass and the document cover. If there is dust or stains on the glass, the copy area may extend to include the dust or stains.
- Load paper in the correct direction and slide the edge guides against the edges of the paper.
- Select the appropriate Original Size in the copy settings.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related references
Copying Options

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac

Related topics
Loading Paper
Placing Originals on the Product

Border Appears on Borderless Prints

If you see a border on borderless prints, try these solutions:

- Make sure you are printing on a compatible borderless paper type and size.
- Windows: Make sure you selected the Borderless setting in your printer software.
• **Mac**: Make sure you selected the **Borderless** checkbox or a paper size with a **Borderless** option in your printer software.

• Adjust the **Expansion** setting to adjust the amount of image expansion on the edges of borderless prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement may not be enough to cover the paper.

• Access the Extended Settings (Windows) or Printing Preferences (Mac) and select **Remove White Borders**.

• Make sure you have stored the paper correctly. Paper can expand or contract if it is not stored properly. See the instructions that came with your paper for storage instructions.

**Parent topic**: Solving Page Layout and Content Problems

**Related tasks**

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

**Incorrect Characters Print**

If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.

• In Windows, delete all print jobs from the Windows Spooler:

  • **Windows 10**: Click (Settings) > Devices > Printers & scanners. Select your product name and select Manage > Open print queue. Right-click the stalled print job, click Cancel, and click Yes.

  • **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select See what's printing, and select your product name again, if necessary. Right-click the stalled print job, click Cancel, and click Yes.

  • **Windows 7**: Click and select Devices and Printers. Right-click your product name, select See what's printing, and select your product name again, if necessary. Right-click the stalled print job, click Cancel, and click Yes.

  • **Windows Vista**: Click and select Control Panel. Click Printer under Hardware and Sound, right-click your product name, and select Open. Right click the stalled print job, click Cancel, and click Yes.

• If your product is connected to a USB hub, connect it directly to your computer instead.
• If your computer entered sleep mode the last time you printed, the next print job after your computer exits sleep mode may contain garbled characters. Print your document again.

• **Windows or Mac:** Make sure you are using the printer software for this product. Check the product name at the top of the driver window.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac

**Incorrect Image Size or Position**

If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.

• Make sure you selected the correct paper size on the control panel.

• Make sure your paper is positioned correctly for feeding into the printer.

• Slide the edge guides against the edges of the paper.

• Clean the scanner glass and document cover.

• If the edges of a copy are cropped, slightly move the original away from the edges of the scanner glass.

• Make sure you selected the correct margins for your paper size in your printing program.

• Be sure to select the correct **Original Size** setting for your original in the Copy settings.

• If the image is slightly enlarged and cropped during borderless printing, change the **Expansion** setting.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related references
Copying Options

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Slanted Printout

If your printouts are slanted, try these solutions:

- Slide the edge guides against the edges of the paper.
- Select a higher print quality setting in your printer software.
- Turn off any high speed settings in your product software.
- Align the print head.
- Make sure the product is not printing while tilted or at an angle.

Parent topic: Solving Page Layout and Content Problems

Related tasks

- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac

Related topics

- Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this manual. See the Apple website for details.

- White or Dark Lines in Printout
- Blurry or Smeared Printout
- Faint Printout or Printout Has Gaps
- Grainy Printout
- Incorrect Colors

Parent topic: Solving Problems
White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Make sure the paper type setting matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- Turn off any high speed settings in your product software.
- Align the print head. If print quality does not improve after aligning the print head, disable the bidirectional (high speed) setting.
- Adjust the print quality in the product software.
- If you are copying from the ADF, copy from the scanner glass instead or use a higher quality setting.
- When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct direction and slide the edge guides to the edges of the paper.
- When vertical banding appears or the paper is smeared, clean the paper path.
- You may need to refill the ink. Visually check the ink levels.
- If you have not used the product for a long time, run the Power Cleaning utility.

**Note:** Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Cleaning
- Print Head Nozzle Check
- Print Head Alignment
- Power Cleaning

**Related references**
- Paper or Media Type Settings - Printing Software
Related tasks
Selecting Printing Preferences - Mac
Selecting Additional Layout and Print Options - Windows
Refilling the Ink Tanks

Related topics
Loading Paper

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Place a piece of black paper on the back of the original and copy it again.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• When manually printing 2-sided, make sure the ink is completely dry before loading the paper.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Dry printouts completely before filing or displaying them. When drying printouts, avoid direct sunlight, do not use a dryer, and do not touch the printed side of the paper.
• Do not stack printouts immediately after printing.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density and/or ink drying time settings.
• If printed copies are smeared, lower the copy density setting on the product control panel.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Clean the paper path.
• Do not press too hard on the original or the document cover when you are scanning originals on the scanner glass.
• Clean the scanner glass.
• Clean the ADF.
• Use the ink before the date printed on the package.
• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has improved.
• If you have not used the product for a long time, run the Power Cleaning utility.

**Note:** Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

**Note:** Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

- Print Head Nozzle Check
- Print Head Cleaning
- Print Head Alignment

**Related references**

- Paper Specifications
- Compatible Epson Papers

**Related tasks**

- Aligning the Print Head Using the Product Control Panel
- Selecting Printing Preferences - Mac
- Selecting Additional Layout and Print Options - Windows
- Selecting Extended Settings - Windows
- Cleaning the Paper Guide
- Selecting Basic Print Settings - Windows
- Selecting Basic Print Settings - Mac
Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Make sure the initial ink charging is complete.
• The ink levels may be low. Visually check the ink levels.
• If any ink levels are below the lower line, refill the ink tanks.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Adjust the print quality in the product software.
• If you have not used the product for a long time, run the Power Cleaning utility.

Note: Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Alignment
Print Head Cleaning

Related references
Paper or Media Type Settings - Printing Software
Paper or Media Type Settings - Control Panel

Related tasks
Cleaning the Paper Guide
Refilling the Ink Tanks

Related topics
Loading Paper
Grainy Printout

If your printouts are grainy, try these solutions:

• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• Adjust the print quality.
• You may need to increase the image resolution or print a smaller size; see your software documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

• If you enlarged the image size in an image-editing program, you need to increase the image resolution setting to retain a high image quality. Increase the image resolution by the same amount you increase the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Cleaning
Print Head Alignment
Print Head Nozzle Check

Related tasks
Selecting Printing Preferences - Mac
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Incorrect Colors

If your printouts have incorrect colors, try these solutions:

• Make sure the paper type setting matches the paper you loaded.
• Make sure the Grayscale setting is not selected in your printer software.
• If you selected Standard-Vivid (Windows) or Normal-Vivid (Mac) as the quality setting in the printer software, try selecting Standard (Windows) or Normal (Mac) instead.
• Select EPSON Standard as the Color Mode (Windows) or Mode (Mac) setting in the printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink levels may be low and you may need to refill the ink. Visually check the ink levels.
• If you printed when the ink levels were too low to be seen in the ink tank windows, refill the ink tanks to the upper lines and run the Power Cleaning utility. Then run a nozzle check to see if print quality has improved.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
• Try turning off the PhotoEnhance setting in Windows.
• Try selecting a different Color Management setting on the More Options tab of the printer software, and changing the Scene Correction setting to something other than Auto Correct.
• For best results, use genuine Epson paper.
• If you have not used the product for a long time, run the Power Cleaning utility.

**Note:** Power Cleaning consumes a lot of ink, so run this utility only if you cannot improve print quality by cleaning the print head.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

- Print Head Nozzle Check
- Print Head Cleaning
- Power Cleaning
Solving Scanning Problems

Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Refilling the Ink Tanks
Managing Color - Mac

Related references
Compatible Epson Papers

Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2

If you cannot start Epson Scan 2, try these solutions:

• Make sure your product is turned on and any interface cables are securely connected at both ends.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If you are scanning with the ADF, check that the document cover and ADF cover are closed.
• Make sure Epson Scan 2 is selected as your scanning program.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan 2.
• Check the connection setting and test the connection using Epson Scan 2 Utility:
  
  **Windows 10**: Click 🔄 and select EPSON > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

  **Windows 8.x**: Navigate to the Apps screen and select Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

  **Windows (other versions)**: Click 🔄 or Start > All Programs or Programs > EPSON > Epson Scan 2 > Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

  **Mac**: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility. Make sure the correct product is selected. If necessary, select the Other tab and click Reset.

• Make sure you do not have multiple versions of Epson Scan 2 installed. If you do, uninstall both versions and install one version.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.

Parent topic: Solving Scanning Problems

Related topics
Starting a Scan

Solving Scanned Image Quality Problems

Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only
Line of Dots Appears in All Scanned Images
Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:

- Make sure you placed your original for scanning facing the correct way.
- If the Image Type setting is Black & White, adjust the Threshold and scan again.
- Remove any lint or dirt from your original.
- Do not press on the original or the document cover with too much force.

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

If you are scanning from the ADF, try cleaning the ADF and scan again.

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.

If you are scanning from the ADF, try cleaning the ADF and scan again.
Image is Distorted or Blurry

If a scanned image appears distorted or blurry, try these solutions:

- Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the scanner glass.
- Do not move your original or your product during scanning.
- Your product will not operate properly while tilted at an angle. Place your product on a flat, stable surface that extends beyond its base in all directions.
- Adjust these Epson Scan 2 settings (if available) and try scanning again:
  - Increase the Resolution setting.
  - If the Image Type setting is Black & White, adjust the Threshold setting.
  - If the Image Type setting is Color or Grayscale, select the Unsharp Mask setting.
  - If the Image Type setting is Black & White, select Text Enhancement. If the Image Type setting is Color or Grayscale, change the Text Enhancement setting to High.

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.

Image is Too Dark

If your scanned image is too dark, try these solutions:

- If the Image Type is set to Color or Grayscale, adjust the Brightness setting.
- Check the brightness and contrast settings of your computer monitor.
Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, try these solutions:

• Place a piece of black paper on the back of the original and scan it again.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:
  • Select the Advanced Settings tab and adjust the Brightness setting.
  • If the Image Type is set to Black & White, select Text Enhancement. If the Image Type is set to Color or Grayscale, change the Text Enhancement setting to High.

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Descreening setting.
• Select a lower Resolution setting.
• Place the original at a slightly different angle.

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.
To adjust the colors in your scanned image, adjust these Epson Scan 2 settings (if available) and try scanning again:

- If the **Image Type** setting is **Color** or **Grayscale**, adjust the **Contrast** setting.
- If the **Image Type** setting is **Black & White** or **Grayscale**, adjust the **Color Enhance** setting.

**Parent topic:** Solving Scanned Image Quality Problems

**Related references**
- Additional Scanning Settings - Main Settings Tab
- Additional Scanning Settings - Advanced Settings Tab

---

**Scanned Image Edges are Cropped**

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

**Parent topic:** Solving Scanned Image Quality Problems

**Related topics**
- Placing Originals on the Product

---

**Characters are Not Recognized During Conversion to Editable Text (OCR)**

If characters in your scanned images are not recognized during OCR conversion, try these solutions:

- Make sure your original is loaded straight on your product.
- Use an original with clear text.
- On the **Image Format Options** window in Epson Scan 2, check that **Text Language** is set correctly on the **Text** tab.
- Select **Settings > Scanner Settings > Scan Settings**, adjust the following settings, and try scanning again:
  - On the **Main Settings** tab, make sure you select the correct **Image Type** for your original.
  - On the **Advanced Settings** tab, select **Text Enhancement** and choose a setting.

  **Note:** The **Text Enhancement** setting depends on the selected **Image Type**.

- If the **Image Type** is set to **Black & White**, adjust the **Threshold** setting on the **Advanced Settings** tab.

**Parent topic:** Solving Scanned Image Quality Problems
Solving Faxing Problems

Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product
Fax Memory Full Error Appears
Fax Quality is Poor
Sent Fax is Received in an Incorrect Size
Received Fax is Not Printed

Parent topic: Solving Problems

Cannot Send or Receive Faxes

If you cannot send or receive faxes, try these solutions:

• If you are faxing from a computer, use the Epson FAX Utility to send your fax.
• Make sure the recipient's fax machine is turned on and working.
• Make sure paper is loaded correctly in your product.
• Make sure you have set up your header information and have not blocked your caller ID. Otherwise, your faxes might be rejected by the recipient's fax machine.
• If you did not connect a telephone to your product, set the Receive Mode setting to Auto so you can receive faxes automatically.
• Check that the cable connecting your telephone wall jack to your product's LINE port is secure.
• Print a fax connection report using your product control panel or fax software to help diagnose the problem.
• Verify that the telephone wall jack works by connecting a phone to it and testing it.
• Check the Line Type setting and set it to PBX. If your phone system requires an external access code to reach an outside line, register the code to the product and add a # (hash) to the beginning of the phone number when dialing.
• If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to enable faxing over the line. Contact your DSL provider for the necessary filter.
• If you are connected to a DSL phone line, connect the product directly to a telephone wall jack and send a fax. If it works, the problem may be caused by the DSL filter. Contact your DSL provider.

• Try lowering your product's fax speed setting.

• Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a color fax.

• If your telephone line uses call waiting and you have trouble receiving faxes, turn off call waiting to prevent disruption of incoming faxes.

• If you have subscribed to a call forwarding service, the product may not be able to receive faxes. Contact your service provider for assistance.

• If the recipient fax machine does not answer your call within 50 seconds after the product has finished dialing, add pauses after the fax number to send the fax.

• Check your inbox and delete faxes after reading or printing them. If the inbox is full, the product cannot receive faxes.

• Check if the sender's fax number is registered to the Rejection Number List.

• If you enabled Rejection Fax options, check if the sender is blocked, did not set up header information, or is not registered in your contacts list, as necessary.

• If you cannot send faxes at a specified time, make sure the date and time are set correctly on the product.

• If you are receiving faxes using the FAX Utility, check that your product is registered as a fax product in your operating system:

  Windows: Make sure the product appears in Devices and Printers, Printer, or Printers and Other Hardware. If the product does not appear, uninstall and re-install the FAX Utility.

  Mac: Select System Preferences > Printers & Scanners (or Print & Scan or Print & Fax) and make sure your product appears. If your product does not appear, click + and add your product. If the product does appear, double-click it and make sure it is not paused.

**Note:** If your product is connected to a VoIP (Voice over Internet Protocol) phone line, keep in mind that fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax transmission will work when using VoIP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received by your voice mail service.

**Parent topic:** Solving Faxing Problems
Cannot Receive Faxes with a Telephone Connected to Your Product

If you cannot receive faxes when a telephone is connected to your product, try these solutions:

- Make sure your telephone is connected to your product's **EXT** port.
- Make sure the Receive Mode is set to **Manual**.

**Note:** When answering a call that is a fax, wait until the product's LCD screen displays a message that a connection has been made before you hang up.

Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine
Receiving Faxes Manually

Fax Memory Full Error Appears

If you see an error message telling you that the product's fax memory is full, try these solutions:

- If you set the product to save received faxes in the product's memory or inbox, delete any faxes you have already read.

  **Note:** Your product can store up to 100 faxes before its inbox is full.

- If you set the product to save received faxes on a computer, turn on the selected computer. Once the faxes are saved on the computer, they are deleted from the product's memory.

- If the memory is full, try sending a monochrome fax using the **Direct Send** feature or sending your faxes in smaller batches.
• If the product cannot print a received fax due to a product error, such as a paper jam, the memory full error may appear. Clear any product errors, then ask the sender to resend the fax.

Parent topic: Solving Faxing Problems
Related tasks
Setting Up the Fax Utility - Windows

Fax Quality is Poor
If you receive a poor quality fax, try these solutions:
• Try enabling the error correction mode (ECM) setting.
• Contact the fax sender and ask them to send the fax in a higher resolution.
• Try reprinting the received fax.

If the sent fax quality is poor, try these solutions:
• Clean the scanner glass.
• Clean the ADF.
• Try changing the resolution or density setting on the control panel.
• If you are sending a monochrome fax to a single recipient, try sending the fax using the Direct Send feature.

Note: If you send a high-resolution monochrome fax without using the Direct Send feature, the product may automatically lower the resolution.

• Try enabling the error correction mode (ECM) setting.

Parent topic: Solving Faxing Problems
Related references
Fax Sending Options
Basic Settings - Fax
Related tasks
Cleaning Your Product
Sent Fax is Received in an Incorrect Size
If your recipient receives a fax in an incorrect size, try these solutions:
• If you are sending a fax using the scanner glass, make sure your original is placed correctly and that the correct paper size is selected on the control panel.
• Clean the scanner glass and document cover.

Parent topic: Solving Faxing Problems
Related tasks
Cleaning Your Product
Related topics
Placing Originals on the Product

Received Fax is Not Printed
If a received fax is not printed, try these solutions:
• Make sure the product is free of errors. The product cannot print received faxes if an error has occurred with the product, such as a paper jam.

Parent topic: Solving Faxing Problems
Related tasks
Selecting Received Fax Options Using the Fax Utility - Windows

Uninstall Your Product Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Close any open programs or applications.
3. Disconnect any interface cables.
4. Do one of the following:
   - **Windows 10**: Click ☑ and select ☑ (Settings) > **Apps** or **System** > **Apps & features**. Then select the program you want to uninstall and select **Uninstall**.
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel** > **Programs** > **Programs and Features**. Select the uninstall option for your Epson product, then select **Uninstall/Change**.

   **Note**: If you see a **User Account Control** window, click **Yes** or **Continue**.

   Select your product again, if necessary, then select **OK**, and click **Yes** to confirm the uninstallation.

   - **Windows (other versions)**: Click ☑ or **Start**, and select **All Programs** or **Programs**. Select **EPSON**, select your product, then click **EPSON Printer Software Uninstall**.

   **Note**: If you see a **User Account Control** window, click **Yes** or **Continue**.

   In the next window, select your product and click **OK**. Then follow any on-screen instructions.

5. Do one of the following to uninstall Epson Scan 2, then follow any on-screen instructions:
   - **Windows 10**: Select **Epson Scan 2** and click **Uninstall**.
   - **Windows 8.x/Windows 7/Windows Vista**: Select **Epson Scan 2** and click **Uninstall/Change**.

6. Restart your computer, then see the **Start Here** sheet to re-install your software.

   **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic**: Uninstall Your Product Software

### Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit [epson.com.jm/support](http://epson.com.jm/support) and select your product.
2. Click **Downloads**.
3. Select your operating system, click **Utilities**, locate the Uninstaller utility, and click **Download**.
4. Run the file you downloaded.
5. Double-click the **Uninstaller** icon.
6. In the Epson Uninstaller screen, select the checkbox for each software program you want to uninstall.
7. Click **Uninstall**.
8. Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

**Note:** If you uninstall the printer driver and your product name remains in the **Print & Fax**, **Print & Scan**, or **Printers & Scanners** window, select your product name and click the – (remove) icon to remove it.

**Parent topic:** Uninstall Your Product Software

### Where to Get Help

If you need additional help with your Epson product, contact Epson. Epson provides these technical support services:

**Internet Support**
Visit Epson's support website at epson.com.jm/support for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

**Speak to a Support Representative**
Before you call Epson for support, please have the following information ready:

- Product name
- Product serial number (located on a label on the product)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

Then call:
<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>(54 11) 5167-0300</td>
</tr>
<tr>
<td></td>
<td>0800-288-37766</td>
</tr>
<tr>
<td>Bolivia*</td>
<td>800-100-116</td>
</tr>
<tr>
<td>Brazil</td>
<td>State capitals and metropolitan areas: 3004-6627</td>
</tr>
<tr>
<td></td>
<td>Other areas: 0800-377-6627 / 0800-EPSONBR</td>
</tr>
<tr>
<td>Chile</td>
<td>(56 2) 2484-3400</td>
</tr>
<tr>
<td>Colombia</td>
<td>Bogota: (57 1) 592-2200</td>
</tr>
<tr>
<td></td>
<td>Other cities: 018000-915235</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>800-377-6627</td>
</tr>
<tr>
<td>Dominican Republic*</td>
<td>1-888-760-0068</td>
</tr>
<tr>
<td>Ecuador*</td>
<td>1-800-000-044</td>
</tr>
<tr>
<td>El Salvador*</td>
<td>800-6570</td>
</tr>
<tr>
<td>Guatemala*</td>
<td>1-800-835-0358</td>
</tr>
<tr>
<td>Mexico</td>
<td>Mexico City: (52 55) 1323-2052</td>
</tr>
<tr>
<td></td>
<td>Other cities: 01-800-087-1080</td>
</tr>
<tr>
<td>Nicaragua*</td>
<td>00-1-800-226-0368</td>
</tr>
<tr>
<td>Panama*</td>
<td>00-800-052-1376</td>
</tr>
<tr>
<td>Paraguay</td>
<td>009-800-521-0019</td>
</tr>
<tr>
<td>Peru</td>
<td>Lima: (51 1) 418-0210</td>
</tr>
<tr>
<td></td>
<td>Other cities: 0800-10-126</td>
</tr>
<tr>
<td>Uruguay</td>
<td>00040-5210067</td>
</tr>
<tr>
<td>Venezuela</td>
<td>(58 212) 240-1111</td>
</tr>
</tbody>
</table>

* Contact your local phone company to call this toll-free number from a mobile phone.
If your country does not appear in the list, contact the sales office in the nearest country. Toll or long distance charges may apply.
Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper from an Epson authorized reseller. To find the nearest reseller, visit epson.com.jm or call your nearest Epson sales office.

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Windows System Requirements
Mac System Requirements
Paper Specifications
Printable Area Specifications
Automatic Document Feeder (ADF) Specifications
Scanning Specifications
Ink Specifications
Fax Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

• Windows 10
• Windows 8.x
• Windows 7
• Windows Vista
• Windows Server 2016
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2
• Windows Server 2008
• Windows Server 2003 R2
• Windows Server 2003 SP2 or later

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com/jm/support, select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

### Mac System Requirements

To use your product and its software, your Mac should use one of these operating systems:

• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

**Note:** For the latest product software available for your operating system, visit the Epson support site at epson.com/jm/support, select your product, and select **Downloads**.

**Parent topic:** Technical Specifications

### Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
Single-sheets

Size
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- 8.5 × 13 inches [216 × 330 mm]
- Legal (8.5 × 14 inches [216 × 356 mm])
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- Executive (7.25 × 10.5 inches [184 × 267 mm])
- 8 × 10 inches (203 × 254 mm)
- Mexico-Oficio (8.5 × 13.4 inches [216 × 340 mm])
- Oficio 9 (8.46 × 12.4 inches [215 × 315 mm])
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- Half Letter (5.5 × 8.5 inches [140 × 216 mm])
- User-defined size paper from 2.12 × 3.39 inches (54 × 86 mm) to 8.5 × 47.24 inches (215.9 × 1200 mm)

Note: Printing on user-defined paper sizes is available only when printing from a computer.

Paper types
- Plain paper

Note: Your product also supports compatible papers distributed by Epson. See the link at the end of this topic for a list of compatible Epson papers.

Weight
- Plain paper: 17 lb (64 g/m²) to 24 lb (90 g/m²)

Envelopes

Size
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

Paper types
- Plain bond paper

Weight
- 20 lb (75 g/m²) to 24 lb (90 g/m²)
Printable Area Specifications

**Note:** When printing borderless, quality may decline in the expanded printable area.

**Single sheets - borders**

1. Top/bottom/left/right margins: 0.12 inch (3 mm) minimum
2. Reduced print quality area/top: 1.61 inches (41 mm) minimum
3. Reduced print quality area/bottom: 1.46 inches (37 mm) minimum

**Single sheets - borderless**

1. Reduced print quality area/top: 1.73 inches (44 mm) minimum
Reduced print quality area/bottom: 1.57 inches (40 mm) minimum

Envelopes

1 Right/left margins: 0.12 inch (3 mm) minimum
2 Top/bottom margins: 0.20 inch (5 mm) minimum
3 Reduced print quality area/right: 0.71 inch (18 mm) minimum
4 Reduced print quality area/left: 1.61 inches (41 mm) minimum

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

<table>
<thead>
<tr>
<th>Paper size</th>
<th>US letter, legal, A4, or 8.5 × 13 inch (216 × 330 mm) size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper type</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Paper weight</td>
<td>17 lb (64 g/m²) to 25 lb (95 g/m²)</td>
</tr>
<tr>
<td>Sheet feeding capacity</td>
<td>Total thickness: 0.13 inch (3.3 mm)</td>
</tr>
<tr>
<td></td>
<td>Approximately 30 sheets (US letter or A4) or 10 sheets (legal or 8.5 × 13 inch [216 × 330 mm])</td>
</tr>
</tbody>
</table>

Parent topic: Technical Specifications
Scanning Specifications

Scanner type: Flatbed, color
Photoelectric device: CIS
Effective pixels: 10200 × 14040 pixels (1200 dpi)
Document size: Maximum: 8.5 × 11.7 inches (216 × 297 mm)
Scanner glass: US letter or A4
Scanning resolution: 1200 dpi (main scan)
2400 dpi (sub scan)
Output resolution: 50 to 9600 dpi in 1 dpi increments
Image data:
Color:
48 bits per pixel internal (16 bits per pixel per color internal)
24 bits per pixel external (8 bits per pixel per color external)
Grayscale:
16 bits per pixel internal
8 bits per pixel external
Black and white:
16 bits per pixel internal
1 bit per pixel external

Light source: LED

Parent topic: Technical Specifications

Ink Specifications

Note: This product is designed to work with genuine Epson inks. Non-Epson ink or any other ink not specified for this printer could cause damage not covered by Epson's warranties.

The ink bottles that are used for initial product setup have a lower yield due to the ink charging process. This process is carried out the first time you turn on the printer and guarantees better performance. Yields vary considerably based on print jobs, print settings, paper type, frequency of use, and temperature. Do not load paper before refilling the ink tanks.
Check the ink levels in your product frequently, and refill the ink tanks if necessary.

**Color**
- Cyan, Magenta, Yellow, Black

**Ink life**
- Opened package: Use as soon as possible
- Unopened package: Use before the date on the package has expired

**Temperature**
- Storage: –4 to 104 °F (–20 to 40 °C)
- 1 month at 104 °F (40 °C)
- Ink freezes at 5 °F (–15 °C)
- Ink thaws and is usable after 2 hours at 77 °F (25 °C)

**Fax Specifications**

**Fax type**
- Walk-up black-and-white and color fax capability (ITU-T Super Group 3)

**Supported lines**
- Standard analog phone line
- PBX (Private Branch Exchange) telephone systems

**Speed**
- Up to 33.6 kbps

**Resolution**
- **Monochrome**:
  - Standard: 203 pixels per inch × 98 lines per inch (8 pixels per mm × 3.85 lines per mm)
  - Fine: 203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7 lines per mm)
  - Photo: 203 pixels per inch × 196 lines per inch (8 pixels per mm × 7.7 lines per mm)

- **Color**:
  - 200 × 200 dpi
Page memory: Up to 100 (ITU-T No. 1 chart in monochrome draft mode)
Redial: 2 times (with 1 minute interval); specifications may differ by country or region
Interface: RJ-11 Phone Line
RJ-11 Telephone set connection

Parent topic: Technical Specifications

Dimension Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Stored</th>
<th>Printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>9.3 inches (237 mm)</td>
<td>10.0 inches (253 mm)</td>
</tr>
<tr>
<td>Width</td>
<td>14.8 inches (375 mm)</td>
<td>14.8 inches (375 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>13.7 inches (347 mm)</td>
<td>22.8 inches (578 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>Approximately 11 lb (5 kg)</td>
<td></td>
</tr>
</tbody>
</table>

(without ink or power cord)

Parent topic: Technical Specifications

Electrical Specifications

Note: Check the label on the product for its voltage.

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power supply rating</td>
<td>100 to 240 V</td>
</tr>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.4 to 0.2 A</td>
</tr>
</tbody>
</table>
Power consumption with USB connection
Standalone copying: Approximately 12 W (ISO/IEC24712)
Ready mode: Approximately 4.3 W
Sleep mode: Approximately 0.7 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature
Operating: 50 to 95 °F (10 to 35 °C)
Storage: –4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity
Operating: 20 to 80% RH
(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type
Hi-Speed USB

Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi
Standard
IEEE 802.11 b/g/n; IEEE 802.11n available only on the 20 MHz channel

Security
WPA2-PSK (AES); complies with WPA2 with support for WPA/WPA2 Personal
WEP (64/128 bit); not supported for Wi-Fi Direct mode

Frequency range
2.4 GHz
Maximum Radio-Frequency Power Transmitted
Coordination modes

<table>
<thead>
<tr>
<th>Coordination modes</th>
<th>Infrastructure mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b</td>
</tr>
</tbody>
</table>

**Note:** Wi-Fi Direct Simple AP mode available even if you connect the product to an Ethernet network.

**Ethernet**

**Standard**

<table>
<thead>
<tr>
<th>Standard</th>
<th>IEEE802.3i (10BASE-T); use a category 5e or higher STP (Shielded Twisted Pair) cable to prevent risk of radio interference</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IEEE802.3u (100BASE-TX)</td>
</tr>
<tr>
<td></td>
<td>IEEE802.3az (Energy Efficient Ethernet); disabled by default (see link below to enable)</td>
</tr>
</tbody>
</table>

**Note:** The connected device should be IEEE802.3az compliant

**Communication mode**

<table>
<thead>
<tr>
<th>Communication mode</th>
<th>Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full duplex, 100Mbps Half duplex</th>
</tr>
</thead>
</table>

**Connector**

<table>
<thead>
<tr>
<th>Connector</th>
<th>RJ-45</th>
</tr>
</thead>
</table>

**Security Protocol**

SSL/TLS: HTTPS Server/Client, IPPS

**Safety and Approvals Specifications**

**United States**

Safety: UL60950-1
EMC: FCC part 15 Subpart B Class B

**Canada**

Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN/CSA-CEI/IEC CISPR 22 Class B
This equipment contains the following wireless module:

- Manufacturer: Seiko Epson Corporation.
- Type: J26H006

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

**Notice for Argentina**

Fax Module

CNC ID: H-17496

WLAN Module

CNC ID: C-20841

**Notice for Mexico**

Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

Product Model: C622A (L5190)

Brand: EPSON

IFT Certification Number: TTDEPC618-1327

WLAN Module Model: J26H006

Brand: EPSON

IFT Certification Number: RCPEPJ218-0025
Notice for Paraguay
Imported by:
Fastrax, S.A.
Av. Perú esq. Río de Janeiro, Barrios Las Mercedes, Asunción, Paraguay
Imported by:
Sol Control S.R.L.
Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asunción, Paraguay

Notice for Peru
Product Model: L5190 (C622A)
Brand: EPSON
This product uses a fax module:
FCC ID: BKMFA01AC612A
This product uses the following WLAN module:
WLAN Module Model: J26H006
FCC ID: BKMFBJ26H006
Product Manufacturer: Seiko Epson Corporation
Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan

Parent topic: Technical Specifications
Notices

Check these sections for important notices about your product.

Important Safety Instructions
FCC Compliance Statement
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions

Parent topic: Notices

General Product Safety Instructions

• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• Make sure the AC power cord meets the relevant local safety standard.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.
• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

- Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.
- If you will not be using the product for a long period, unplug the power cord from the electrical outlet.
- Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
- Allow space behind the product for the cables, and space above the product so that you can fully raise the document cover.
- Leave enough space in front of the product for the paper to be fully ejected.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Do not place or store the product outdoors.
- Do not place the product near excessive heat sources or in direct sunlight.
- Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
- Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
- Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your product's radio waves from affecting the operation of the pacemaker.
- When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
- Do not touch the flat white cable or ink tubes inside the product.
- Do not move the print head by hand; this may damage the product.
- Do not put your hand inside the product while it is printing.
- Do not spill liquid on the product or use the product with wet hands.
- Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.
- Do not press too hard on the document table when placing originals.
- Be careful not to trap your fingers when closing the document cover or scanner.
- Except as specifically explained in your documentation, do not attempt to service or disassemble the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

• Before transporting the product, make sure that the print head is in the home (far right) position.

• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise, ink may leak.

• Some users that print extensively may receive a message informing them that the ink waste pad is full. The duration of the pad depends on the amount of use and usage conditions such as high humidity, heat or dusty conditions that require more cleaning cycles. The Epson Status Monitor and warning light on the control panel will indicate when the waste pad needs to be replaced. The ink pad is not a user serviceable part. Please seek service from an Epson Authorized Service Center or consider a new printer if your printing needs have changed or the printer has had a long period of extensive use.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

• Do not press too hard on the LCD screen or subject it to heavy impacts.

• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.

• If the LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson for support.

• The LCD screen may contain a few small bright or dark spots, and may display uneven brightness. These are normal and do not indicate that the screen is damaged in any way.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.
Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk of fire, electric shock, and personal injury, including the following:

• Do not use the Epson product near water.
• Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.
• Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments ("ACTA"). On the surface of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEO##TXXXX. If requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company. For products approved after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEO##TXXXX. The digits represented by ## are the REN without a decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. But if advance notice isn’t practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of the equipment. If this happens the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment may not be used on coin service provided by the telephone company. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, click the link below for instructions on entering fax header information.

According to the FCC’s electrical safety advisory, we recommend that you may install an AC surge arrester in the AC outlet to which this equipment is connected. Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user's authority to operate the equipment.

For Canadian Users

1. This product meets the applicable Innovation, Science and Economic Development Canada technical
specifications.

2. The Ringer Equivalence Number indicates the maximum number of devices allowed to be connected
to a telephone interface. The termination of an interface may consist of any combination of devices
subject only to the requirement that the sum of the RENs of all the devices does not exceed five.

CAN ICES-3(B)/NMB-3(B)

Le présent produit est conforme aux spécifications techniques applicables d'Innovation, Sciences et
Développement économique Canada.

L'indice d'équivalence de la sonnerie (IES) sert à indiquer le nombre maximal de dispositifs qui peuvent
être raccordés à une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelconque de dispositifs, à la seule condition que la somme des IES de tous les dispositifs
n’excède pas cinq.

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices
Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term "Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim, controversy or action between you and Epson arising out of or relating to this Agreement, Epson branded products (hardware and including any related software), or other transaction involving you and Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation, ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement, (c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson also agree, notwithstanding Section 1.6, that a court, not an arbitrator, may decide if a claim or cause of action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED. Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C. §1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to resolve the Dispute within the sixty (60) days, you or Epson may commence an arbitration. Notice to Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way, Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent address Epson has in its records for you. For this reason, it is important to notify us if your address changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of the Dispute shall include the sender's name, address and contact information, the facts giving rise to the Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 **Small Claims Court.** Notwithstanding the foregoing, you may bring an individual action in the small claims court of your state or municipality if the action is within that court’s jurisdiction and is pending only in that court.

1.5 **WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS.** YOU AND EPSON AGREE THAT EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED. ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY’S CLAIMS WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION PROCEEDING.

1.6 **Arbitration Procedure.** If you or Epson commences arbitration, the arbitration shall be governed by the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration on a class or representative basis (the "JAMS Rules"), available at [https://www.jamsadr.com/about/](https://www.jamsadr.com/about/) or by calling +1-949-224-1810 (from outside the U.S.) or 1-800-352-5267 (from within the U.S.), and under the rules set forth in this Agreement. All Disputes shall be resolved by a single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising out of or relating to the interpretation, applicability, enforceability or formation of this Agreement, including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1 above. The arbitrator shall be empowered to grant whatever relief would be available in a court under law or in equity. The arbitrator may award you the same damages as a court could, and may award declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent necessary to provide relief warranted by that party’s individual claim. In some instances, the costs of arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration than in court. The arbitrator’s award is binding and may be entered as a judgment in any court of competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by telephone shall take place in a location reasonably accessible from your primary residence, or in Orange County, California, at your option.

a) **Initiation of Arbitration Proceeding.** If either you or Epson decides to arbitrate a Dispute, both parties agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount of damages sought to be recovered. You can find a copy of a Demand for Arbitration at http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled. The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section 1.6d) above does not limit your rights to attorney's fees and expenses under applicable law; notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual arbitration procedure and waiver of class and representative proceedings specified in this Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent to this Agreement (including without limitation the purchase, download, installation of the Software or other applicable use of Epson Hardware, products and services) that specifies (i) your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding individual arbitration procedure and waiver of class and representative proceedings specified in this Section 1. In the event that you opt-out consistent with the procedure set forth above, all other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson’s address) in this Agreement, Epson will obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not apply to the prohibition against class or representative actions as provided in Section 1.5. This means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1) shall be null and void.

Parent topic: Notices

Trademarks

EPSON® is a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™ is a trademark of Seiko Epson Corporation.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.

Use of the Works with Apple badge means that an accessory has been designed to work specifically with the technology identified in the badge and has been certified by the developer to meet Apple performance standards.

Google® is a registered trademark and Android™, Google Drive™, Google Play™, Google Cloud Print™, Chromebook™, Google Chrome™, and Gmail™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

Copyright © 1988-1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Copyright Attribution

© 2019 Epson America, Inc.
11/19
CPD-56096R1

Parent topic: Copyright Notice